Make sure you check for updates to this manual at the Oracle Technology Network (OTN) Web site
Copyrights and Trademarks

Copyright © 1995, 2007, Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are
provided under a license agreement containing restrictions on use and disclosure and are also protected by
copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or
decompilation of the Programs, except to the extent required to obtain interoperability with other independently
created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the
documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may
be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced
or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf
of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data
delivered to U.S. Government customers are "commercial computer software" or "commercial technical data"
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such,
use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical
data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the
extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted
Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous
applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other
measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim
liability for any damages caused by such use of the Programs.

Oracle and Agile are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be
trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle
is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks
associated with the use of such content. If you choose to purchase any products or services from a third party, the
relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party
products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of
products or services and warranty obligations related to purchased products or services. Oracle is not responsible for
any loss or damage of any sort that you may incur from dealing with any third party.

September 13, 2007
## Revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Pages Affected</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>5/10/06</td>
<td>All</td>
<td>Initial release of manual.</td>
</tr>
<tr>
<td>B</td>
<td>5/26/06</td>
<td>1-3, 2-6, 2-7, 2-10, 2-12, 2-13, 2-14, 3-23, 5-2</td>
<td>Release 9.2.1.2, documented support for WebSphere Portal Express 5.02.</td>
</tr>
</tbody>
</table>
CONTENTS

Preface

Agile PLM Documentation ................................................................. ix
Readme ............................................................... ix
Agile Training ................................................................. ix
Developer Documentation and Samples ........................................... ix

Chapter 1 Introduction

About Agile Portlet Services ............................................................. 1-1
What’s New ........................................................................ 1-2
IBM WebSphere Portal Server ......................................................... 1-3
Portlet Communication and Collaboration ....................................... 1-3

Chapter 2 Installing and Upgrading Agile Portlet Services

Installation Sequence ................................................................. 2-1
Installing IBM WebSphere Portal .................................................... 2-2
Upgrading to WebSphere Portal 5.1.0.2 ........................................ 2-2
Installing WebSphere Application Server and IBM HTTP Server as a Windows Service .................................................... 2-2
Web Server Considerations ........................................................ 2-3
WebSphere Application Server Tuning ........................................... 2-3
Launching and Verifying the WebSphere Portal ................................ 2-4
Navigating in the WebSphere Portal ............................................. 2-4
Configuring the WebSphere Portal for LDAP .................................. 2-5
Creating Portal Users and User Groups .......................................... 2-5
Installing Agile Portlet Services ................................................... 2-6
Setting Agile Portlet Services Application Parameters .................... 2-6
Setting Application Parameters for Copies of Agile Portlets .............. 2-9
Setting Up the Agile Portlet Configurator ...................................... 2-10
Configuring the JNLP MIME Type .............................................. 2-11
Upgrading Agile Portlet Services to Agile PLM 9.2.1 ..................... 2-12
Using the XML Upgrade Tool .................................................... 2-12
Updating Agile Portlet Services ................................................... 2-12
Clearing the Agile SDK Cache .................................................... 2-13
Setting Agile Portlet Parameters .................................................. 2-13
Creating Portal Pages .............................................................. 2-18
Editing the Layout of a Page ...................................................... 2-19
Administering Pages .................................................................. 2-20
Setting Resource Permissions .................................................... 2-20
Using Custom Themes and Skins .................................................. 2-20
Agile PLM Administration Settings Related to Portlets .................. 2-21

Chapter 3 Configuring Agile Portlets

About Portlet Configuration ............................................................ 3-1
Portlet Modes ........................................................................... 3-2
Configuring the Advanced Search Portlet ...................................... 3-2
Configuring a Quick Links Portlet ................................................ 3-2
Setting Up Quick Links to Portal Pages ............................................................... 3-4
Configuring the Report Folder Browser Portlet ............................................. 3-4
Using the Portlet Configurator ........................................................................ 3-4
  Roles and Privileges Needed to Use Agile Portlet Configurator ...................... 3-5
  Launching the Agile Portlet Configurator ....................................................... 3-5
  Portlet Configurator Toolbar ....................................................................... 3-6
  Portlet Configurator Tabs ............................................................................. 3-6
  Portlet Configurator Navigation .................................................................. 3-6
Using Portlet Configurator to Modify a Configuration ..................................... 3-7
Using the Classes Tab ..................................................................................... 3-7
Using the Configure Tab .................................................................................. 3-8
  Attribute Groups .......................................................................................... 3-9
  Tables .......................................................................................................... 3-10
  Action Groups ............................................................................................ 3-11
  Adding the Edit Action to an Actions Group ............................................... 3-12
  Adding the Change Status Action to an Actions Group ............................... 3-12
  Adding the New Action to an Actions Group .............................................. 3-13
Portlet Layout ................................................................................................. 3-13
Messaging Between Portlets ......................................................................... 3-15
  Clearing Portlets If Messaging Is Not Supported ........................................ 3-16
Exporting and Importing Portal Configurations using the XML Configuration Interface ............................................................... 3-17
Using Process Extensions from within Portlets ............................................. 3-18
  Configuring a New Process Extension Action for a Portlet ......................... 3-19
  Testing a Sample Process Extension within a Portlet ................................ 3-19
Creating Custom Help for Agile Portlets ...................................................... 3-21
  Downloading Online Help Files for Agile Portlets .................................... 3-22
  Configuring Online Help for Portlets on WebSphere Portal 5.1.0.2 ......... 3-22
  Configuring Online Help for Portlets on WebSphere Portal 5.022 ............ 3-23

Chapter 4     Using Agile Portlets

Agile Portlet Features ...................................................................................... 4-1
Using Edit Mode to Personalize Agile Portlets .............................................. 4-2
Filtering Data in Portlets ............................................................................... 4-2
Advanced Search Portlet ............................................................................... 4-3
  Using Advanced Search .............................................................................. 4-3
    OR Searches ............................................................................................. 4-5
    AND Searches .......................................................................................... 4-5
    AND NOT Searches .................................................................................. 4-5
    Matching Exact Phrases ......................................................................... 4-5
  Personalizing the Advanced Search Portlet ................................................ 4-5
    Edit Mode Options .................................................................................. 4-6
    Configure Mode Options ......................................................................... 4-6
Attachment Files Portlet ............................................................................... 4-6
  Edit Mode Options .................................................................................... 4-7
  Configure Mode Options ........................................................................... 4-7
Bookmarks Portlet ......................................................................................... 4-7
Business Object Portlet ............................................................................... 4-8
Clipboard Portlet ............................................................................................. 4-9
My Notifications and Requests Portlet .......................................................... 4-9
  Configure Mode Options ........................................................................... 4-10
My Things To Do Portlet ................................................................................ 4-10
  Displaying Things To Do by Due Date ....................................................... 4-11
    Configure Mode Options ........................................................................ 4-11
Quick Links Portlet .......................................................................................... 4-11

PREFACE

The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web site contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on your network from which you can access the Oracle|Agile documentation (PDF) files.

To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be downloaded from the www.adobe.com.

The Oracle Technology Network (OTN) Web site can be accessed through Help > Manuals in both the Agile Web Client and the Agile Java Client. If applicable, earlier versions of Oracle|Agile PLM documentation can be found on the www.agile.com/support.

If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for assistance.

Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology Network (OTN) Web site.

Agile Training Aids

Go to the Agile Training Web page for more information on Agile Training offerings.
This chapter introduces Agile Portlet Services. It includes the following topics:

- About Agile Portlet Services
- What’s New
- IBM WebSphere Portal Server
- Portlet Communication and Collaboration

About Agile Portlet Services

A portal is a Web site that provides internal and external users with a single point of access to a company’s Web-based resources. The portal’s single sign-on provides access to any number of small applications, called portlets, that let users manage various types of information. Users can personalize their own portal pages, making the portal more efficient, usable, and highly tailored to meet their individual needs.

A portal usually contains several portlets. Each portlet provides users access to specific content or actions. Agile provides several predefined portlets that can be integrated with a company’s portal. Agile Portlet Services expose commonly-used Agile PLM functionality through a company’s portal and allow users to quickly link to specific Agile product content.

The following figure shows a simplified portal system, one that doesn’t include load balancers, application server clusters, proxy Web servers, or LDAP servers.

Figure 1-1: Simplified portal system
Agile Portlet Services includes the following portlets:

Table 1-2: Agile Portlets

<table>
<thead>
<tr>
<th>Category</th>
<th>Portlet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Advanced Search</td>
<td>Searches for Agile PLM objects by matching one or more field values.</td>
</tr>
<tr>
<td>Search</td>
<td>Quick Search</td>
<td>Searches for Agile PLM objects by specifying a single matching value.</td>
</tr>
<tr>
<td>Search</td>
<td>Saved Search</td>
<td>Displays results for a saved search.</td>
</tr>
<tr>
<td>Search</td>
<td>Search Folder Browser</td>
<td>Allows you to browse search folders and select a particular search to run.</td>
</tr>
<tr>
<td>Search</td>
<td>Search Results</td>
<td>Works in conjunction with Advanced Search, Quick Search, and Search Folder Browser portlets. When you click a search in search portlet, the results appear in the Search Results portlet.</td>
</tr>
<tr>
<td>Content</td>
<td>Attachment Files</td>
<td>Shows a selected Attachments table for objects.</td>
</tr>
<tr>
<td>Content</td>
<td>Business Object</td>
<td>Shows an Agile PLM business object (such as an item or change) to view or modify its fields.</td>
</tr>
<tr>
<td>Productivity</td>
<td>My Notifications and Requests</td>
<td>Shows the current user’s Agile PLM notifications and requests.</td>
</tr>
<tr>
<td>Productivity</td>
<td>My Things to Do</td>
<td>Shows lists of things the current user needs to complete, including Action Items, Program Activities, and Workflow Routings.</td>
</tr>
<tr>
<td>Utility</td>
<td>Bookmarks</td>
<td>Shows the current user’s Agile PLM bookmarks.</td>
</tr>
<tr>
<td>Utility</td>
<td>Clipboard</td>
<td>Lets you collect Agile PLM objects to later perform actions on them.</td>
</tr>
<tr>
<td>Utility</td>
<td>Quick Links</td>
<td>Lets you add links to other portal pages or to external Web pages.</td>
</tr>
<tr>
<td>Utility</td>
<td>Quick Navigation</td>
<td>Lets you navigate to bookmarked or recently visited Agile PLM objects, or display the contents of the Clipboard.</td>
</tr>
<tr>
<td>Utility</td>
<td>Report Folder Browser</td>
<td>Lets you generate a report from one of the Report folders.</td>
</tr>
<tr>
<td>Utility</td>
<td>Single Signon</td>
<td>Allows you to enter a user ID and password to enable single signon between the portal and the Agile PLM server.</td>
</tr>
<tr>
<td>Utility</td>
<td>Upload File</td>
<td>Adds a new file to the Agile PLM system.</td>
</tr>
<tr>
<td>Utility</td>
<td>User Profile</td>
<td>Lets you view and edit your Agile PLM user profile.</td>
</tr>
</tbody>
</table>

What’s New

Agile Portlet Services provides the following new features with Agile PLM 9.2.1:

- **Portlet messaging** – Portlets now have a new parameter that defines how the portlet communicates with itself, the page, or other pages when you click an object link in the portlet. Previously, an object link would always send a message to the current page. For more information, see “portlet.messaging” on page 2-16 and “Messaging Between Portlets” on page 3-15.

- **Business Object portlet enhancements** – The Business Object portlet can now send messages to itself, updating the content that appears in the portlet. The portlet can also be configured for multiple object classes. A new “breadcrumbs” feature allows you to backtrack to previous views of the portlet, enhancing portlet navigation.

- **Portlet Configurator enhancements** – The Portlet Configurator applet has been enhanced to support the ability to configure multiple classes for each Business Object portlet instance. The user interface has also been improved. For more information, see “Using the Portlet Configurator” on page 3-4.

- **XML Upgrade Tool** – Agile provides a command-line Java utility that upgrades Business Object Portlet XML configuration files from version 9.0 or 9.1 to 9.2.1. For more information, see “Using the XML Upgrade Tool” on page 2-12.
**IBM WebSphere Portal Server**

Agile Portlet Services are currently supported on IBM WebSphere Portal Enable for Multiplatforms 5.1.0.2 and IBM WebSphere Portal Express for Multiplatforms 5.022.

For complete WebSphere Portal installation instructions, hardware and software requirements, and configuration and troubleshooting information, please see the IBM WebSphere Portal InfoCenter. Use any of the following methods to access the IBM WebSphere Portal InfoCenter:

- Click the **InfoCenter** button available in the WebSphere Portal installation program.
- Go to the WebSphere Portal InfoCenter URL.
- After WebSphere Portal is installed, click **Start > All Programs > IBM WebSphere > Portal Server > Information Center**.

**Portlet Communication and Collaboration**

Agile portlets communicate with each other using portlet actions and portlet messages. The portlets work together to share information with each other. For example, the Search Results portlet works with one of the Search portlets (such as the Quick Search portlet) to display a table of search results. If you click one of the search results, the object’s contents can appear in a Business Object portlet on the same page.

The following figure shows how three portlets can communicate with each other to share information and update each other’s contents.
Figure 1-3: Portlets communicating with one another

1. The user clicks a pending change...

2. The user clicks an Affected Item...

...which updates the Changes portlet.

...which updates the Items portlet.

**Note** You can control whether Business Object portlet clears the portlet of its contents if the message received from another portlet (such as a Search portlet) is not supported. For more information, see “Setting Agile Portlet Parameters” on page 2-13.
This chapter describes how to install and upgrade Agile Portlet Services. It includes the following topics:

- Installation Sequence
- Installing IBM WebSphere Portal
- Installing Agile Portlet Services
- Setting Agile Portlet Services Application Parameters
- Setting Up the Agile Portlet Configurator
- Upgrading Agile Portlet Services to Agile PLM 9.2.1
- Using the XML Upgrade Tool
- Updating Agile Portlet Services
- Clearing the Agile SDK Cache
- Setting Agile Portlet Parameters
- Creating Portal Pages
- Agile PLM Administration Settings Related to Portlets

**Installation Sequence**

These instructions assume you have purchased the required hardware and software, and installed IBM WebSphere Portal as well as Agile PLM 9.2.1 before beginning to install Agile Portlet Services.

**To install and configure Agile Portlet Services:**

1. Install Agile PLM 9.2.1 and all its server-side components (database, file server, LDAP server, and so on). Agile Portlet Services connect to the Agile Application Server and cannot work without it. For detailed instructions on how to install the Agile Application Server, see the separate Agile PLM installation guide.

2. Install IBM WebSphere Portal on a separate server from the Agile Application Server.


4. Configure Agile Portlet Services application parameters.

5. If you are not using an LDAP server to authenticate users, create portal users and user groups. Otherwise, configure the Portal Server to use an LDAP server for authentication.
6 Set up the Agile Portlet Configurator on a Web server so that portlet administrators can launch it to configure portlets easily.

7 Create separate portal pages that use the Agile portlets. Some Agile portlets require configuration before they can be used.

   Note On one portal page, you must add the Agile Single Signon portlet. Portal users can then personalize the portlet to log into the Agile PLM server. Otherwise, portal users won’t be able to use the Agile portlets.

8 Configure each of the Agile portlets, especially those based on the Business Object portlet. For Business Object portlets, you can edit each portlet’s XML configuration or use the separate Agile Portlet Configurator application.

   Note The WebSphere Portal Server XML configuration interface can be used to transfer the configuration of one portal to another. This is useful when moving from a development environment to a production environment. For more information about the XML configuration interface, see “Exporting and Importing Portal Configurations using the XML Configuration Interface” on page 3-17, as well as the IBM WebSphere Portal InfoCenter.

### Installing IBM WebSphere Portal

Because WebSphere Portal ships with multiple software components and works with other database, Web server, and LDAP server products, there are many different installation scenarios. For complete installation instructions, please see the IBM WebSphere Portal InfoCenter.

To install WebSphere Portal:

Insert the WebSphere Portal Setup CD and follow the onscreen instructions.

**Important** Do not install WebSphere Portal Server into a path with spaces (such as “d:\Program Files\WebSphere”).

### Updating to WebSphere Portal 5.1.0.2

If you are running WebSphere Portal 5.1, you should run two separate fix packs from IBM to update to WebSphere Portal 5.1.0.2. Click the following links to download the fix packs:

- WebSphere Portal 5.1 Cumulative Fix 1
- WebSphere Portal 5.1 Cumulative Fix 2

You can also download these fix packs by going to the IBM web site (http://www.ibm.com/us/). Search for “WebSphere Portal 5.1 Cumulative Fix 1” and “WebSphere Portal 5.1 Cumulative Fix 2” (both in quotes).

### Installing WebSphere Application Server and IBM HTTP Server as a Windows Service

If you are going to run WebSphere Application Server and IBM HTTP Server (if you are installing it) as a Windows service, you must install the product as a user with the following local policy rights:

- Act as part of the operating system
- Log on as a service

The WebSphere Portal installer assigns these local policy rights to your account automatically, but you will need to log out and log in again before continuing the installation.
Web Server Considerations
You can install the Web server on the portal machine or on a separate machine. If you install the Web server on a remote server, you should also consider installing the WebSphere Application Server plug-in, which takes care of load balancing between remote Application Server instances in a clustered environment. The plug-in will also allow you to change the WebSphere Portal URI.

For more information about WebSphere Application Server plug-in, see the IBM WebSphere Portal InfoCenter.

WebSphere Application Server Tuning
After you install WebSphere Portal Server, you should tune the installation of WebSphere Application Server to optimize performance.

Use the WebSphere Application Server administrative console to tune the server.

To access the WebSphere Application Server administrative console:
1. Stop the WebSphere Portal Server.
2. Start the WebSphere Application Server.
3. In a Web browser, type the following URL:
   http://<fully_qualified_hostname>:9090/admin
   where <fully_qualified_hostname> is the fully qualified host name of the server running the WebSphere Application Server.
4. Log in using the administrative user ID and password.
5. Tune the WebSphere Application Server using the recommended settings in Table 2-1.
6. Save the WebSphere Application Server settings.
7. Stop the WebSphere Application Server.
8. Start the WebSphere Portal Server.

Table 2-1: WebSphere Application Server tuning parameters

<table>
<thead>
<tr>
<th>Category</th>
<th>Parameter</th>
<th>Recommended Setting</th>
<th>How to Configure in the Admin Console</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Virtual Machine</td>
<td>Maximum Heap Size</td>
<td>1 Gb or more</td>
<td>Servers &gt; Application Servers &gt; WebSphere_Portal &gt; Process Definition &gt; Java Virtual Machine</td>
</tr>
<tr>
<td></td>
<td>Generic JVM Arguments</td>
<td>-Xnoclassgc 1</td>
<td>Servers &gt; Application Servers &gt; WebSphere_Portal &gt; Process Definition &gt; Java Virtual Machine</td>
</tr>
<tr>
<td>Servlet Caching</td>
<td>Enable Servlet Caching</td>
<td>Enabled (make sure the box is checked)</td>
<td>Servers &gt; Application Servers &gt; WebSphere_Portal &gt; Web Container &gt; Servlet Caching</td>
</tr>
<tr>
<td>Dynamic Cache Service</td>
<td>Enable Service at Server Startup</td>
<td>Enabled (make sure the box is checked)</td>
<td>Servers &gt; Application Servers &gt; WebSphere_Portal &gt; Dynamic Cache Service &gt; Startup State</td>
</tr>
<tr>
<td>Session Management</td>
<td>Session Timeout</td>
<td>10 minutes</td>
<td>Servers &gt; Application Servers &gt; WebSphere_Portal &gt; Web Container &gt; Session Management</td>
</tr>
<tr>
<td>Thread Pool</td>
<td>Maximum Size</td>
<td>70</td>
<td>Servers &gt; Application Servers &gt; WebSphere_Portal &gt; ORB Service &gt; Thread Pool</td>
</tr>
<tr>
<td>JDBC Providers</td>
<td>Statement Cache Size</td>
<td>500-1000</td>
<td>Resources &gt; JDBC Providers &gt; JDBC_provider &gt; Data Sources &gt; data_source</td>
</tr>
<tr>
<td></td>
<td>Max Connections</td>
<td>25 or more</td>
<td>Resources &gt; JDBC Providers &gt; JDBC_provider &gt; Data Sources &gt; data_source &gt; Connection Pool</td>
</tr>
</tbody>
</table>
Notes:
1. Disables class garbage collection, making class reuse more available, and slightly improving performance.
2. You can monitor the cache size in Tivoli Performance Viewer to see if it’s large enough.
3. Applies only if you migrate from the default Cloudscape database to an Oracle database. Otherwise, use the default setting.

Launching and Verifying the WebSphere Portal

The best way to verify that WebSphere Portal has been installed and is working properly is to launch your portal and sign in.

To launch WebSphere Portal:
1. Make sure the Web server and WebSphere Portal server are running.
2. Open a browser and go to the WebSphere Portal URL:
   \[http://<hostname>:<port>/<baseURI>/<homepage>\]
   For example, if you accepted the default values during installation, enter the following URI:
   \[http://<hostname>:9081/wps/portal\]
   The portal should load in the browser.
3. Click Log In. Enter the administrative user ID and password. Click Log In.

If you have trouble either loading the WebSphere Portal in the browser or logging in as the administrator, see the IBM WebSphere Portal InfoCenter for troubleshooting information.

Navigating in the WebSphere Portal

The following figure shows the controls that enable you to navigate the WebSphere Portal.

Figure 2-1: Navigating in WebSphere Portal

Different parts of the WebSphere Portal screen are described below:
- **Banner** – Includes the main structural elements of the default portal page.
- **Pages** – Pages are housed within larger sections. For example, the Home page is located within the Welcome tab. To view a page, click the page name.
My Favorites – Provides a drop-down list of links to the user’s preset favorites.

Content area – Contains one or more portlets.

Configuring the WebSphere Portal for LDAP

If you install an LDAP server to manage users for the Agile Application Server, you can also use it for authentication on the WebSphere Portal. The same LDAP users can then access both systems.

If the portal server will be integrated with LDAP, install the software as a user that exists within the LDAP environment. Note the user ID and password so that you can install WebSphere Fix Packs when necessary.

For more information about setting up LDAP for the WebSphere Portal, see the IBM WebSphere Portal InfoCenter.

Creating Portal Users and User Groups

On a production server, WebSphere Portal supports authentication using an LDAP accessible directory. Ordinarily, you would use the same LDAP server to maintain users for both the Agile Application Server and the WebSphere Portal, thereby simplifying authentication for both systems. If you install WebSphere Portal for the purposes of portlet development, an LDAP directory is not required. In such an installation scenario, the portal administrator must define the users and user groups that use Agile Portlet Services. On a development server, users and user groups are stored in the WebSphere Portal database.

The portal administrator can use the Access Control List portlet to control the access rights that users and user groups have for all portal resources, such as pages, and portlets. You can assign different access rights to each user or user group for each type of resource. Users in a group inherit the access rights assigned to the group.

For more information about WebSphere access control, see the IBM WebSphere Portal InfoCenter.

To create a portal user:
1. Select Administration > Access > Users and Groups.
2. Click the link for All Authenticated Portal Users.
3. Click New User.
4. Enter values for User ID, Password, Confirm Password, First Name, and Last Name, which are all required fields. For Preferred Language, select English. Optionally, specify the user’s email address. Click OK.

To create a user group:
1. Select Administration > Access > Users and Groups.
2. Click the Root link if it is not already selected.
3. Click New Group.
4. Type a name in the Group Name field, and then click Create Group.
5. In the User Groups list, click the name of the group you just created. Click Add Member.
6. Select users by checking the Select box to the left of the user name. Click OK.

To assign access rights to users and user groups:
Select Administration > Access > User and Group Permissions.

See User and Group Permissions portlet help for detailed instructions on using the portlet.

Note If you don’t assign access rights to users, they won’t be able to view Agile portlets and pages. Only the portal administrator will have rights to those resources.
Installing Agile Portlet Services

Based on the license key you used to install Agile PLM 9.2.1 and its service packs, Agile Portlet Services are automatically installed on the Agile Application Server. All Agile portlets are contained in one file, AgilePortletPack2.war. Once you install the file, you must use WebSphere Portal Administration to install the portlets on the portal.

To install Agile Portlet Services on WebSphere Portal Enable 5.1.0.2:

1. Install Agile PLM 9.2.1. For installation instructions, refer to the separate Agile PLM installation guide.
   Agile Portlet Services files are installed into the <agile_home>\Portlet_51 folder on the Agile Application Server.
2. On the Agile Application Server, open a browser window and go to the WebSphere Portal URL. The default URL is: http://<hostname>:9081/wps/portal
3. Click Log In. Enter the administrative user ID and password. Click Log In.
5. Click the Browse button to select the AgilePortletPack2.war file located in the <agile_home>\Portlet_51\war folder on the Agile Application Server.
   If the Agile Application Server is hosted on BEA WebLogic Server, select the AgilePortletPack2.war file located in the <agile_home>\Portlet_51\war\weblogic folder.
6. Click Next.
   The page lists the Agile portlets that will be installed from the WAR file you selected.
7. Click Finish.

To install Agile Portlet Services on WebSphere Portal Express 5.022:

1. Install Agile PLM 9.2.1. For installation instructions, refer to the separate Agile PLM installation guide.
   Agile Portlet Services files are installed into the <agile_home>\Portlet_50 folder on the Agile Application Server.
2. On the Agile Application Server, open a browser window and go to the WebSphere Portal URL. The default URL is: http://<hostname>:9081/wps/portal
3. Click Log In. Enter the administrative user ID and password. Click Log In.
4. Select Administration > Portlets > Install.
5. Click the Browse button to select the AgilePortletPack2.war file located in the <agile_home>\Portlet_50\war folder on the Agile Application Server.
   If the Agile Application Server is hosted on BEA WebLogic Server, select the AgilePortletPack2.war file located in the <agile_home>\Portlet_50\war\weblogic folder.
6. Click Next.
   The page lists the Agile portlets that will be installed from the WAR file you selected.
7. Click Install.

Setting Agile Portlet Services Application Parameters

Agile Portlet Services has several application parameters that are crucial to the successful operation of all Agile portlets. If any one of the application parameters is configured incorrectly, it can cause the portlets to malfunction or fail to connect to the Agile PLM server.

To set Agile Portlet Services application parameters on WebSphere Portal Enable 5.1.0.2:

1. After Agile portlets are installed, log into the WebSphere Portal as an administrative user.
2. Select Administration > Portlet Management > Applications.
Chapter 2 Installing and Upgrading Agile Portlet Services

3 Search for “AgilePortlets 2.1”.
4 Click the Edit Portlet Application icon.
5 Specify parameters shown in Table 2-2.
   The parameter values are read-only. To change a parameter value, do this:
   a Copy the parameter name, and paste it into a text editor (such as Notepad).
   b Click the Delete Parameter icon to remove the parameter. Click OK to confirm.
   c Click OK to save changes.
   d Click the Edit Portlet Application icon again.
   e Copy the parameter name from the text editor, and paste it into the New Parameter text box.
   f Enter the new value for this parameter in the New Value text box.
   g Click to add the new parameter.
6 When you are finished modifying parameters, click OK.

To set Agile Portlet Services application parameters on WebSphere Portal Express 5.022:
1 After Agile portlets are installed, log into the WebSphere Portal as an administrative user.
2 Select Administration > Portlets > Manage Applications.
3 In the Web Modules list, select AgilePortletPack2.war. You can search for it if it’s not listed.
4 In the Portlet Applications Belonging to the Selected Web Module list, select AgilePortlets 2.1 and click Modify Parameters.
5 Specify parameters shown in Table 2-2.
6 Click Save. Agile portlets are now configured to connect to your Agile server.

Table 2-2: Agile Portlet Services application parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VaultSlotName</td>
<td>This is the name of the Credential Vault slot. Agile's Single Signon Portlet creates a slot with this name in the Credential Vault automatically. The default slot name is AgilePLMSlot. Note: Generally, you should not modify the value for VaultSlotName. If you specify a different slot name, you will need to create all user credentials again.</td>
</tr>
<tr>
<td>download.javaPlugin.url</td>
<td>Enter the location of the Java plugin to use for client-side browsers. The Gantt Chart applet uses this URL to download Java Runtime Environment (JRE) version 1.4.2 if the client computer does not have the proper version installed. Default: <a href="http://java.sun.com/j2se/1.4.2/download.html">http://java.sun.com/j2se/1.4.2/download.html</a></td>
</tr>
<tr>
<td>UnzipFilesOnUpload</td>
<td>If you upload a ZIP file to the Agile File Management server, this parameter determines whether a checkbox option will appear in the portlet to allow you to unzip the file automatically. Enter true (the default) or false.</td>
</tr>
<tr>
<td>jvueServerForViewer</td>
<td>The Agile Viewer has a server component usually running on the same computer as the Agile PLM server. It accesses the server via the VueServlet. Enter the URL for the VueServlet. Important: This setting must be identical to the Viewer Server URL setting specified in the Agile Java Client (Admin tab &gt; Server Settings &gt; Locations &gt; File Manager). Format: &lt;protocol&gt;://&lt;proxyServerName&gt;:&lt;proxyPort&gt;/&lt;fileserverVirtualPath&gt;/VueServlet Example: <a href="http://plm.company.com/Filemgr/VueServlet">http://plm.company.com/Filemgr/VueServlet</a></td>
</tr>
</tbody>
</table>
Table 2-2: Agile Portlet Services application parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| webClientFServlet             | Agile File Manager has a servlet deployed with Agile PLM that the Agile Viewer uses to access files stored on the file server. Enter the URL for the servlet so the Agile Viewer client can access files from portlets.  
                                | **Important:** This setting must be identical to the Viewer Proxy URL setting specified in the Agile Java Client (Admin tab > Server Settings > Locations > File Manager).  
                                | **Format:** `<protocol>://<proxyServerName>:<proxyPort>/*fileserverVirtualPath*/VueLink`  
                                | **Example:** `http://plm.company.com/Filemgr/VueLink`                                                                                                                                                    |
| webClientVirtualPath          | Enter the URL for the virtual path for the Web Client proxy server. This URL is used to link from portlets to the Agile Web Client.  
                                | **Format:** `<protocol>://<proxyServerName>:<proxyPort>/*virtualPath>`  
                                | **Example:** `http://plm.company.com/Agile`                                                                                                                                                    |
| portletConfiguratorURL        | Enter the URL for the Portlet Configurator JNLP file. This URL makes it possible to launch the Portlet Configurator applet from the Business Object portlet configuration page to configure Agile portlets. Otherwise, you can configure Agile portlets by editing the XML configuration file.  
                                | **Example:** `http://plm.company.com/configurator/configurator.jnlp`                                                                                                                                     |
| portalAdministratorEmail      | Enter the email address of the portal administrator. This address is used to notify the portal administrator of any errors that occur with Agile portlets.                                                                 |
| createMultipleFileFoldersOn-Upload | If you upload files to the Agile File Management server, this parameter determines whether a checkbox option will appear in the portlet to allows you to add the files to one file folder or multiple file folders. Enter true (the default) or false. |
| codebaseForViewer             | Enter the URL for the Agile Viewer library (jvue.jar).  
                                | **Important:** This setting must be identical to the Viewer Content URL setting specified in the Agile Java Client (Admin tab > Server Settings > Locations > File Manager).  
                                | **Format:** `<protocol>://<proxyServerName>:<proxyPort>/*appserverVirtualPath*/jVue`  
                                | **Example:** `http://plm.company.com/Agile/jVue`                                                                                                                                                    |
| help.base.url                  | Enter the base URL for the Web server location where Agile portlets access online help files. Each portlet can be configured to access a specific help file located relative to this base URL.  
                                | **Example:** `http://portalserver/PortletsHelp`                                                                                                                                                    |
| ppm.weekendDays               | Enter two comma-delimited integers that represent the days of the week that are considered weekends by the Agile Product Portfolio Management (PPM) solution. Weekend days are not counted when Agile PLM calculates start and end dates based on the number of business days estimated for a task.  
                                | **Here is the list of integers for the days of the week:**  
                                |     0=Sunday  
                                |     1=Monday  
                                |     2=Tuesday  
                                |     3=Wednesday  
                                |     4=Thursday  
                                |     5=Friday  
                                |     6=Saturday  
                                | **Default:** `0,6`                                                                                                                                         |
Setting Application Parameters for Copies of Agile Portlets

When you make a copy of a portlet, such as the Business Object portlet or Advanced Search portlet, WebSphere Portal Server also makes a copy of the portlet application, along with its application parameters. If you subsequently make a change to the portlet application parameters, you must make the same change to every copy of the portlet application.

Table 2-2: Agile Portlet Services application parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>server.url</td>
<td>Enter the URL used to connect to the Agile server. Enter the URL in this format: Format: <code>&lt;protocol&gt;://&lt;servername&gt;:&lt;port&gt;/&lt;virtualPath&gt;</code> where • <em>protocol</em> is HTTP or HTTPS. • <em>servername</em> is the name of the Agile PLM server computer, not the proxy server. • <em>port</em> is the port number used for the specified server. Default ports are: IBM WebSphere Application Server = 9080 Oracle Application Server = 7777 BEA WebLogic Server = 7001 • <em>virtualPath</em> is the virtual path for your Agile server. The virtual path is specified when the Agile system is installed. By default, the virtual path is “Agile”. Examples: Oracle Application Server: <a href="http://plm.company.com:7777/Agile">http://plm.company.com:7777/Agile</a> BEA WebLogic Server: <a href="http://plm.company.com:7001/Agile">http://plm.company.com:7001/Agile</a></td>
</tr>
<tr>
<td>server.timeout</td>
<td>The Agile PLM server session timeout value. Do not confuse this with the portal session timeout. The Agile PLM server will timeout after a specified number of minutes. The portal administrator can use this parameter to align the session timeout from Agile portlets with that of the Agile PLM server. To specify a timeout value, enter a positive number in minutes. To use the same timeout setting as the application server, specify a negative value. To never timeout, enter zero (0). Default: 60 (minutes)</td>
</tr>
</tbody>
</table>

Each copy of the AgilePortlets 2.1 application should be configured with the same application parameters.
**Setting Up the Agile Portlet Configurator**

The Agile Portlet Configurator provides an easy-to-use graphical user interface for configuring the Business Object portlets, which has many configuration options. When you install Agile Portlet Services, the Agile Portlet Configurator files are installed into the following folder:

- **WebSphere Portal Enable 5.1.0.2:** `<agile_home>\Portlet_51\configurator`
- **WebSphere Portal Express 5.022:** `<agile_home>\Portlet_50\configurator`

Before you can launch the Agile Portlet Configurator applet, you need to add the files to your Web server and perform some configuration steps. You can use the Agile Portlet Configurator to configure only Agile Business Object and User Profile portlets. It cannot be used to configure other portlets.

To set up the Agile Portlet Configurator:

1. Copy the `<agile_home>\Portlet_51\configurator` or `<agile_home>\Portlet_50\configurator` folder to your Web server’s docroot directory. The following table lists default docroot directories for several Web servers:

<table>
<thead>
<tr>
<th>Web Server</th>
<th>Default docroot directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Information Server (IIS)</td>
<td>c:\InetPub\wwwroot</td>
</tr>
<tr>
<td>IBM HTTP Server</td>
<td>c:\IBMHttpServer\htdocs</td>
</tr>
<tr>
<td>Apache Web Server</td>
<td>c:\Apache\htdocs</td>
</tr>
</tbody>
</table>

2. Configure your Web server so that it handles JNLP files. This is necessary so that Java Web Start can successfully download the application classes from the network and install it on your computer. For instructions on setting the JNLP MIME type for both IIS and Apache Web servers, see “Configuring the JNLP MIME Type” below.

3. In the `<docroot>\configurator` folder, open the configurator.jnlp file, and change the codebase and href parameters in the jnlp tag to reference the correct locations on your Web server. See the text in bold below. After you edit the file, save it.

```xml
<?xml version="1.0" encoding="utf-8" ?>
<jnlp spec="1.0+" codebase="http://webserver/configurator" href="http://webserver/configurator/configurator.jnlp">
  <information>
    <title>Agile Portlet Configurator</title>
    <vendor>Agile Software Corporation</vendor>
    <description>Agile Portlet Configurator</description>
    <description kind="tooltip">Agile Portlet Configurator</description>
    <!--<icon href="photonpc64.gif"/>-->
    <offline-allowed/>
  </information>
  <security>
    <all-permissions/>
  </security>
  <resources>
    <j2se version="1.3+" max-heap-size="640m"/>
    <jar href="configurator.jar"/>
    <jar href="AgileAPI.jar"/>
    <jar href="crimson.jar"/>
    <jar href="jaxp.jar"/>
    <jar href="xalan.jar"/>
  </resources>
  <application-desc main-class="com.agile.ui.portal.portlets.bizObject.configure.PortletConfigurationApplet">
```

---

**Note**  
When you copy a portlet and consequently make a copy of the AgilePortlets application, you can rename the new application to identify the portlet it’s associated with.
4 Set the portletConfiguratorURL parameter for Agile Portlet Services to the same URL you used in the previous step. For instructions on how to change the portletConfiguratorURL application parameter, see “Setting Agile Portlet Services Application Parameters” on page 2-6.

5 Test whether the Agile Portlet Configurator is working by opening a browser and typing the following URL:

   http://<webserver>/configurator/configurator.jnlp

   The Portlet Configurator login dialog box appears.

   **Note** If the Portlet Configurator doesn’t load successfully, make sure the URLs specified in the configurator.jnlp file and the portletConfiguratorURL parameter match one another and are correct. Also, make sure Java Runtime Environment (JRE) 1.4.2 or later is installed on the client machine. For more troubleshooting information about the Portlet Configurator, see page 5-3 of the “Troubleshooting” chapter.

6 To log in, enter a valid Agile PLM user name and password. For the Server URL, type the same URL used for the serverURL application parameter (for example, http://plm.company.com:7777/Agile). Click **OK**.

   The Portlet Configurator window appears.

---

### Configuring the JNLP MIME Type

A JNLP file is an XML document that describes a Java application to be launched by Java Web Start. To successfully download and install applications using Java Web Start, you must configure the JNLP MIME type for your server.

#### To configure the JNLP MIME type on Windows:

1. Choose **Start > All Programs > Administrative Tools > Internet Information Services (IIS) Manager**.

   The Internet Information Services (IIS) Manager window appears.

2. Expand the folder for **Internet Information Services > servername**.

3. Select the **Web Sites > Default Web Site** folder, right-click, and choose **Properties** from the shortcut menu.

   The Default Web Site Properties dialog box appears.

4. Click the **HTTP Headers** tab.

5. Click the **MIME Types** button.

   The MIME Types dialog box appears.

6. Click the **New** button.

7. In the **Extension** field, type **.jnlp**. In the **MIME Type** field, type **application/x-java-jnlp-file**. Click **OK**.

8. The new file type appears in the Registered MIME Types box. Click **OK** to close the MIME Types dialog box.

9. Click **OK** to close the Default Web Site Properties dialog box.

10. Restart IIS.

#### To configure the MIME type on Solaris:

1. Locate the **mime.types** file in the **conf** directory of the Apache Web server.

2. Add the following line to the **mime.types** file:

   ```
   application/x-java-jnlp-file       JNLP
   ```

3. Restart the Apache Web server.
Upgrading Agile Portlet Services to Agile PLM 9.2.1

To upgrade an existing installation of Agile Portlet Services from Agile PLM 9.0 or 9.1 to 9.2.1, follow these steps:

1. Upgrade your Agile PLM application server and database to Agile PLM 9.2.1.
2. (Optional) Upgrade from WebSphere Portal Express 5.022 to WebSphere Portal Enable 5.1.0.2.
3. Log into the WebSphere Portal as an administrator and uninstall any existing Agile PLM 9.0 or 9.1 portlets.
4. Install new Agile PLM 9.2.1 portlets. For instructions, see “Installing Agile Portlet Services” on page 2-6.
6. Update Agile PLM portlet pages for your portal.
7. If you configured the Business Object Portlet for your portal, you can update XML configuration files to the Agile PLM 9.2.1 format using the XML Upgrade Tool. See the next section.

Using the XML Upgrade Tool

The XML Upgrade Tool is a simple command-line Java utility for upgrading Business Object Portlet XML configuration files from version 9.0 or 9.1 to 9.2.1. The main difference in the Business Object Portlet configuration is that it now supports configurations for multiple classes. You can use the XML Upgrade Tool to convert an old XML configuration file to the new format. You can also concatenate multiple XML configuration files together into one new XML file.

To update an existing Business Object Portlet XML configuration file to Agile 9.2.1 format:

1. On the computer where Agile Portlet Services are installed, open a command prompt window.
2. Change to the XML Upgrade Tool folder:
   - WebSphere Portal Enable 5.1.0.2: <agile_home>\Portlet_51\xmlupgradetool
   - WebSphere Portal Express 5.022: <agile_home>\Portlet_50\xmlupgradetool
3. Run the following command:
   
   ```java
   java -classpath ./XMLUpgradeTool.jar;./jdom.jar
   com.agile.ui.portal.portlets.bizObject.configure.tools.XMLUpgradeTool file1 [file2...filen]
   ```

   At least one input file argument is required. Files must use fully qualified paths, such as c:\temp\bop1.xml. Separate multiple files with spaces. If you specify multiple files, the XML Upgrade Tool combines them into one output file.

   The output file is created in the same directory where you ran the XML Upgrade Tool. The name of the output file is the concatenation of the input filenames plus “_921.xml”.

   The following example shows how to combine two files named bop1.xml and bop2.xml into a new output file named bop1.xml_bop2.xml_921.xml.

   ```java
   java -classpath ./XMLUpgradeTool.jar;./jdom.jar
   com.agile.ui.portal.portlets.bizObject.configure.tools.XMLUpgradeTool
   c:\temp\bop1.xml c:\temp\bop2.xml
   ```

   After you create the new Agile 9.2.1 XML configuration file, you can copy it into the Portlet Configurator to configure an Agile 9.2.1 Business Object Portlet.

Updating Agile Portlet Services

If you receive an updated Agile Portlet Services WAR file and you’ve already installed Agile portlets on the WebSphere Portal, you don’t need to reinstall them. Instead, follow these steps to update Agile portlets.
Chapter 2  Installing and Upgrading Agile Portlet Services

To update the Agile Portlet Services WAR file on WebSphere Portal 5.1.0.2:
1 Open a browser window and go to the WebSphere Portal URL. The default URL is http://<hostname>:9081/wps/portal.
2 Click Log In. Enter the administrative user ID and password. Click Log In.
3 Select Administration > Portlet Management > Web Modules.
4 Find AgilePortletPack2.war, and then click the Update Web Module icon.
5 Click the Browse button to select the updated AgilePortletPack2.war file. Click Next.
6 The Manage Web Modules page lists the portlets that will be updated from the WAR file you selected. Click Finish to begin updating them.
7 After installation is finished, stop the WebSphere Portal and clear the Agile SDK cache on the portal server. See the next section.

To update the Agile Portlet Services WAR file on WebSphere Portal 5.022:
1 Open a browser window and go to the WebSphere Portal URL. The default URL is http://hostname:9081/wps/portal.
2 Click Log In. Enter the administrative user ID and password. Click Log In.
3 Select Administration > Portlets > Manage Applications.
4 In the Web Modules list, select AgilePortletPack2.war and then click Update.
5 Click the Browse button to select the updated AgilePortletPack2.war file. Click Next.
6 The Manage Portlet Applications tab lists the portlets that will be updated from the WAR file you selected. Click Install.
7 After installation is finished, stop the WebSphere Portal and clear the Agile SDK cache on the portal server. See the next section.

Clearing the Agile SDK Cache
Whenever you update the Agile Portlet Services WAR file by installing an Agile 9.2.1 service pack, you must clear the Agile SDK cache on the WebSphere Portal computer. When you delete the Agile SDK cache, it forces Agile portlets to use the network class loader to download the latest classes, which allow Agile portlets to connect to the updated Agile 9.2.1 server.

To clear the Agile SDK cache:
1 Stop the WebSphere Portal.
2 Open a Command Prompt window.
3 Change to the %temp% directory:
   cd %temp%
4 Delete the Agile SDK cache subdirectory:
   del AgileSDK.cache
5 You are prompted “Are you sure?” Enter Y for Yes.
6 Restart the WebSphere Portal.

Setting Agile Portlet Parameters
Before placing Agile portlets on a page to define the layout of your portal, you should set the parameters for each portlet you intend to use.
Note  Several portlet parameters are designed to be modified only from the portal page when the portlet is in Configure mode. To enter configure mode, go to the portal page and click the portlet’s wrench icon. Other users can personalize the portlet by clicking the pencil icon in the portlet’s title bar.

To modify portlet parameters for WebSphere Portal 5.1.0.2:

1  Select Administration > Portlet Management > Portlets.
2  Click the Configure Portlet icon for an Agile portlet. The Manage Portlets page appears.
3  For the parameter you want to change, click the Edit Parameter icon. Agile portlet parameters are listed in Table 2-4.
4  In the Value field, enter a new value.
5  Click OK.

To modify portlet parameters for WebSphere Portal 5.022:

1  Select Administration > Portlets > Manage Portlets.
2  Select a portlet, and click Modify Parameters. The configuration parameters window opens.
3  Edit the parameter values. Agile portlet parameters are listed below in Table 2-4.
4  Click Save.

Table 2-4: Agile portlet parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Agile Portlets</th>
</tr>
</thead>
<tbody>
<tr>
<td>clearPortletContentsIfMessageNotSupported</td>
<td>If set to true, this parameter clears the portlet of its contents if a message received from another portlet (such as a Search portlet) is not supported. Default: false</td>
<td>Business Object</td>
</tr>
<tr>
<td>customTitle</td>
<td>An optional custom title for the portlet that appears in the portlet’s title bar.</td>
<td>All</td>
</tr>
<tr>
<td>disableTableStatusFlags</td>
<td>If set to true, the portlet disables status flag attributes such as Has Attachments and Has Action Items. Default: false (status flag attributes are enabled)</td>
<td>Business Object Saved Search Search Results</td>
</tr>
<tr>
<td>help.relativePath</td>
<td>The relative path of this portlet’s help file. The relative path is combined with the help.base.url value to create the complete URL for the help file.</td>
<td>All</td>
</tr>
<tr>
<td>help.url</td>
<td>The complete URL for an online help file for this portlet. This URL overrides the URL specified by the help.relative.path portlet parameter and the help.base.url application parameter.</td>
<td>All</td>
</tr>
<tr>
<td>mTTConfiguredViews</td>
<td>Specify the comma-delimited series of selected views for the portlet. Default: 1,0,2 0 = My Workflow Routings 1 = My Action Items 2 = My Activities</td>
<td>My Things To Do</td>
</tr>
<tr>
<td>mTTPossibleViews</td>
<td>Specify the comma-delimited series of possible views for the portlet. Default: 1,0,2 0 = My Workflow Routings 1 = My Action Items 2 = My Activities</td>
<td>My Things To Do</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Agile Portlets</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>notfConfiguredViews</td>
<td>Specify the comma-delimited series of selected views for the portlet.</td>
<td>My Notifications and Requests</td>
</tr>
<tr>
<td></td>
<td><strong>Default:</strong> 0,1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0 = My Notifications</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 = My Requests</td>
<td></td>
</tr>
<tr>
<td>notfPossibleViews</td>
<td>Specify the comma-delimited series of possible views for the portlet.</td>
<td>My Notifications and Requests</td>
</tr>
<tr>
<td></td>
<td><strong>Default:</strong> 0,1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0 = My Notifications</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 = My Requests</td>
<td></td>
</tr>
<tr>
<td>objectType</td>
<td>The currently selected Agile object type used in the Advanced Search portlet.</td>
<td>Advanced Search</td>
</tr>
<tr>
<td></td>
<td><strong>Not Supported. Use the portlet’s Configure mode to configure it.</strong></td>
<td></td>
</tr>
<tr>
<td>pageid_Report_cstRptCfgEnabled</td>
<td>Equivalent to the <strong>Enable Customer External Reports</strong> checkbox in the portlet’s Configure mode.</td>
<td>Report Folder Browser</td>
</tr>
<tr>
<td></td>
<td>A separate cstRptCfgEnabled parameter is provided for each portal page on which the Report Folder Browser portlet has been added. Possible values for the parameter are 0 (false) and 1 (true).</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Default:</strong> 0</td>
<td></td>
</tr>
<tr>
<td>pageid_Report_rootFolderId</td>
<td>Select a report folder by specifying its numeric ID.</td>
<td>Report Folder Browser</td>
</tr>
<tr>
<td></td>
<td>To find the ID number of a report folder, move the mouse over a folder in the Report Folder Browser portlet. The ID number appears in the browser’s status bar.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A separate rootFolderId parameter is provided for each portal page on which the Report Folder Browser portlet has been added.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>The portlet’s Configure mode offers a much easier graphical user interface for selecting a report folder.</strong></td>
<td></td>
</tr>
</tbody>
</table>
portlet.messaging | Defines how the portlet communicates with itself, the page, or other pages when you click an object link in the portlet. Specify one of the following values:

- **Empty string ("")** – This is equivalent to removing the portlet.messaging parameter from the portlet, which causes the default behavior to be used. If you click a link for an object supported by a Business Object portlet, the portlet sends a message to itself. For other objects not supported by the Business Object portlet and for all other portlets, the default behavior is for the portlet to send a message to the current page when you click an object link.

- **"page"** – The portlet sends a message to the current page.

- **"none"** – Object links in the portlet appear as normal text. When you click the text, the portlet does not send a message.

- **An internal portal URL** – If the portlet.messaging parameter is not an empty string, "page", or "none", the portlet assumes the value is a URL that has been mapped to another portal page. The portlet sends the object context to the portal page identified by the URL. The URL must be an internal portal page that uses WebSphere’s URL mapping. For more information on how to use URL mapping, see the IBM WebSphere Portal InfoCenter.

  Internal portal URLs are of the format:

  `/wps/myportal/mypage`

  where *mypage* is the mapped URL for the page. The internal portal URL is appended to the portal prefix (http://hostname:port).

  **Important:** The URL mapping must be all lower case.

  When you click an object link in the portlet, the context of the object is attached to the URL as a querystring parameter.

  **Note:** Changes to the portlet.messaging parameter do not take effect until you log out of the portal and log in again (to clear the cache).

queryCriteria | Defines the search criteria used for the Advanced Search portlet.

  **Not Supported. Use the portlet’s Configure mode to configure it.**

quickLinksXml | Defines the XML configuration for the Quick Links portlet.

  **Not Supported. Use the portlet’s Configure mode to configure it.**
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Agile Portlets</th>
</tr>
</thead>
<tbody>
<tr>
<td>quickSearchInfoText</td>
<td>Sample query information to help users enter a value to search for in the Quick Search portlet. This sample query text appears when you click the Show Sample Queries link in the portlet.</td>
<td>Quick Search</td>
</tr>
<tr>
<td>ReportServerSettingKeys</td>
<td>Aggregates the keys that have been set for all portal pages on which the Report Folder Browser has been added. Not Supported. Use the portlet’s Configure mode to configure it.</td>
<td>Report Folder Browser</td>
</tr>
<tr>
<td>savedSearchId</td>
<td>The ID number of a saved search. The results of the search will appear in the Quick Navigation portlet. Not Supported. This parameter is obsolete and does not affect the Quick Navigation portlet.</td>
<td>Quick Navigation</td>
</tr>
<tr>
<td>scrollBarHeightLimit</td>
<td>The height of portlet data. If portlet data exceeds the specified height, a vertical scroll bar appears. This parameter does not set the height of the portlet. To do that, you must edit the page layout.</td>
<td>Quick Navigation</td>
</tr>
<tr>
<td>scrollBarWidthLimit</td>
<td>The width of portlet data. If portlet data exceeds the specified width, a horizontal scroll bar appears. This parameter does not set the width of the portlet. To do that, you must edit the page layout.</td>
<td>Quick Navigation</td>
</tr>
<tr>
<td>searchableAttributes</td>
<td>The list of available attributes that can be used in search criteria. Not Supported. Use the portlet’s Configure mode to configure it.</td>
<td>Advanced Search</td>
</tr>
<tr>
<td>searchConfigurationXML</td>
<td>Defines the XML configuration for the Advanced Search portlet. Not Supported. Use the portlet’s Configure mode to configure it.</td>
<td>Advanced Search</td>
</tr>
<tr>
<td>Search_savedSearchId</td>
<td>Select a saved search by specifying its numeric ID. To find the ID number for a saved search, move the mouse over a saved search in the Search Folder Browser portlet. The ID number appears in the browser’s status bar. The portlet’s Configure mode offers a much easier graphical user interface for selecting a saved search.</td>
<td>Saved Search</td>
</tr>
<tr>
<td>searchDisplayAttributes</td>
<td>The list of available attributes that can be used in search results. Not Supported. Use the portlet’s Configure mode to configure it.</td>
<td>Advanced Search</td>
</tr>
<tr>
<td>simpleSearchInfoText</td>
<td>A brief message that provides information about a Simple Search to help users of this portlet. Not Supported. Simple Search is no longer an option of the Advanced Search portlet.</td>
<td>Advanced Search</td>
</tr>
</tbody>
</table>

Table 2-4: Agile portlet parameters (continued)
Table 2-4: Agile portlet parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Agile Portlets</th>
</tr>
</thead>
<tbody>
<tr>
<td>supportedSearchTypes</td>
<td>Specify the Agile object types that can be searched for in the Advanced Search portlet. Not Supported. Use the portlet’s Configure mode to configure it.</td>
<td>Advanced Search</td>
</tr>
<tr>
<td>tableHeight</td>
<td>The height of the table that appears in the portlet. If the table exceeds the specified height, a vertical scroll bar appears. To enable tableHeight and tableWidth parameters, both must be set to nonzero values. Default: 0 (disabled) This parameter does not set the height of the portlet. To do that, you must edit the page layout.</td>
<td>Business Object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Saved Search</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Search Results</td>
</tr>
<tr>
<td>tableWidth</td>
<td>The width of the table that appears in the portlet. If the table exceeds the specified width, a horizontal scroll bar appears. To enable tableHeight and tableWidth parameters, both must be set to nonzero values. Default: 0 (disabled) This parameter does not set the width of the portlet. To do that, you must edit the page layout.</td>
<td>Business Object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Saved Search</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Search Results</td>
</tr>
</tbody>
</table>

Creating Portal Pages

The WebSphere Portal has a hierarchical structure of nodes. Each node is an element in the portal navigation tree. There are three types of nodes:

- **page** — Displays content in the form of portlets.
- **label** — Container for other nodes. Labels are used to group nodes in navigation.
- **URL** — An addressable resource, such as external Web pages or pages within the portal site.

The topmost node in the portal navigation tree is the content root. After you install WebSphere Portal, the following nodes appear under the content root:

- **My Portal** — a label containing portlets for general use. This is the default page displayed after login.
- **Administration** — a label used containing pages with portlets used to administer the WebSphere Portal.
- **Page Customizer** — a label with child pages used to manage page content and layout.
- **Page Properties** — a page used to edit the properties of portal page.
- **Organize Favorites** — a page containing the Organize Favorites portlet, which lets portal users organize their favorite labels and URLs. You can access the Organize Favorites page using the My Favorites list in the banner.

Users without administrative privileges can access only the **My Portal** node. Administrators can use links in the banner to switch between **Administration** and **My Portal**.

A page displays content, or portlet applications. Each page can contain one or more portlets. To view a page, first select the place. Once the place is selected, you can click a page within the place.

**To create an Agile label in My Portal:**

1. Select **Administration > Portal User Interface > Manage Pages**.
2. Click the **My Portal** label.
3. Click **New Label**.
4 Type Agile and click **OK**.
5 The Properties page appears. Click **OK**.

To add a page to the Agile label:

1 Select **Administration > Portal User Interface > Manage Pages**.
2 Select **Content Root > My Portal > Agile**.
3 Click **New Page**.
4 Type the name of the page and click **OK**. For example, type **Programs** to create a page showing Agile programs.
5 The Properties page appears. Click **OK**.

**Note** Portal pages can be imported from a portal configuration file using IBM’s XML Access tool. For more information, see “Exporting and Importing Portal Configurations using the XML Configuration Interface” on page 3-17.

### Editing the Layout of a Page

WebSphere Portal lets you control the layout of portal pages, select and arrange portlets on a page, and edit portlets that require configuration.

Pages can contain columns, rows, and portlets. You can fill the columns and rows with portlets or other columns and rows. You can also create nested pages.

To create a page with Agile portlets, you must select a logical group of portlets to display Agile content. A page you create might include:

- the Single Signon portlet, which connects a user to the Agile PLM server. Only one Single Signon portlet is needed for your portal. The same connection is used for all Agile portlets on multiple pages.
- a Search portlet to locate Agile PLM content. Quick Search and Advanced Search are examples of Search portlets.
- a Content portlet, such as a copy of the Business Object portlet, to display data for a selected object.

To edit the layout of a portal page:

1 Select **Administration > Portal User Interface > Manage Pages**.
2 Select a portal page to edit.
3 Click the **Edit Page Layout** icon.

Some of the options you can select on the page include:

- **Layout template**: Select from several preconfigured page layouts.
- **Add portlets**: Select portlets to add to the page.
- **Show layout tools**: Shows advanced layout tools for creating and editing page containers. This option overrides the preconfigured layout templates. For example, you can set the column width.

The following figure shows an example of a two-column layout for a page that includes the Single Signon, Quick Search, Search Results, and Item (Business Object) portlets.
Administering Pages

The portal administrator can permit specified users to change the layout of a page. If you have authority to change a page, you can use Administration > Manage Pages to modify the layout. For each page, you can click the Set Page Permission icon to specify the permissions that users have to edit the page.

For more detailed information about creating and modifying places and pages, see the “Managing Pages, Layout, and Content” topic in the IBM WebSphere Portal InfoCenter.

Setting Resource Permissions

In addition to creating users and user groups, the portal administrator can specify permissions for all types of portal resources, including pages and individual portlets. This allows the portal administrator to set the level of personalization for each page or each portlet.

To access Resource Permissions for your portal, use one of these methods:

- Choose Administration > Access > Resource Permissions.
- Click Assign permissions in the page banner.
- Click the Set Permission icon in the Manage Pages portlet.

For more detailed information about setting resource permissions, see the “Authorization” topic in the IBM WebSphere Portal InfoCenter.

Using Custom Themes and Skins

Portal pages also have themes and skins, which are usually created by the Web designer of the portal. Themes control the look and feel of the portal, including colors and fonts. For each theme, there are one or more skins that define the style of the area surrounding individual portlets. To set the default theme and skin for the portal, select Administration > Portal User Interface > Themes and Skins.
If you create custom themes or skins, you can test them on a development system. After the themes and skins are fully developed and tested, you must update and redeploy the WebSphere Portal EAR file with the new themes and skins.

For more information about custom themes and skins, see the IBM WebSphere Portal InfoCenter.

**Agile PLM Administration Settings Related to Portlets**

After Agile Portlet Services are successfully installed and configured, the Agile PLM administrator must configure the application server to interface with the portal properly. The administrator must perform the following tasks to ensure that Agile PLM users can launch the portal Web site from email notifications they receive.

The Preferred Client user preference specifies which Agile PLM client to launch from email notifications. The available choices are Java Client, Web Client, or Portal Client. The Preferred Portal URL user preference specifies which portal URL to go to if the user selected Portal Client as his preferred client.

For more information about Agile PLM administration, see the *Agile PLM Administrator Guide*.

**To add a portal URL to the Agile PLM server:**

1. Log into the Agile Java Client as an administrator.
2. Choose Admin > Server Settings > Locations > Portals.
3. Click the New toolbar button to add a portal URL.
4. In the Name field, type the name of the portal.
5. In the Portal field, type the portal URL.
6. In the Enabled list, select Yes.
7. Click OK.

**To configure the Agile PLM portal as your preferred Agile PLM client for email notifications:**

1. Log into the Agile Web Client.
2. Choose Admin > User Settings > Users.
4. Click User Profile.
5. Click the Preferences tab.
6. Click Edit.
7. Click the Preferred Client list and select Portal Client.
8. Click the Preferred Portal URL list and select a portal.
9. Click Save.

- **Note** If the Preferred Portal URL list reads “No Privilege,” make sure the Modify Users privilege for Agile PLM applies to the “users.Preferences.Preferred Portal URL” attribute.
CHAPTER 3
Configuring Agile Portlets

This chapter describes how to configure and personalize Agile portlets. It includes the following topics:
- About Portlet Configuration
- Portlet Modes
- Configuring the Advanced Search Portlet
- Configuring a Quick Links Portlet
- Configuring the Report Folder Browser Portlet
- Using the Portlet Configurator
- Messaging Between Portlets
- Exporting and Importing Portal Configurations using the XML Configuration Interface
- Using Process Extensions from within Portlets
- Creating Custom Help for Agile Portlets

About Portlet Configuration

This section describes how to configure Agile portlets. For most portlets, configuration is simple and requires selecting just a few options. The Business Object and User Profile portlets, however, are more complicated and have many more options for content and layout. You can configure those portlets by editing the XML configuration or using the Portlet Configurator.

Once an Agile portlet is placed on a page, it can be used by people connecting to the portal. However, the following Agile portlets must be configured before they can be used:
- Advanced Search
- Business Object
- Quick Links
- Saved Search
- Search Folder Browser
- User Profile

To configure a portlet from the page layout:

1. Select Administration > Portal User Interface > Manage Pages.
2. Select a portal page that uses Agile portlets.
3. Click the Edit Page Layout icon.
4. Select an Agile portlet, such as one based on the Business Object portlet, and click the Edit Portlet icon.
To configure a portlet from a portal page:
1 Select a portal page.
2 Click the Configure icon (a wrench) for a portlet.

Portlet Modes
Each portlet has up to four possible display modes:
- **View** — Shows the portlet’s normal user interface.
- **Help** — Shows a help window with information about the portlet. Although Agile Portlet Services does not include online help, you can create your own custom online help for each Agile portlet.
- **Edit** — Shows a page that lets users personalize a portlet. Portlets that support Edit mode have a pencil icon.
- **Configure** — Shows a page that allows portal administrators to configure a portlet. Portlets that support Configure mode have a wrench icon.

Configuring the Advanced Search Portlet
The Advanced Search portlet has a graphical user interface for specifying its configuration, but it’s more complex than other Agile portlets, partly because it also requires that you’re familiar with the Agile API query language. This section steps you through the somewhat tricky process of configuring an advanced search.

To configure the Advanced Search portlet:
1 Select a portal page with the Advanced Search portlet, and click the wrench icon to enter Configure mode.
2 In the Select Class To Search drop-down list, select the class or subclass to search for.
   - If you select a base class (such as Items), a different set of search and display attributes can be configured for each class. If you select a class (such as Parts), a different set of search and display attributes can be configured for each subclass.
3 In the Define Search For drop-down list, select a class.
4 Select one or more attributes to include in the search parameters, and then click ➔ to move them into the Selected Attributes box.
5 Select attributes to display in the search results, and then click ➔ to move them into the Selected Attributes box.
6 To exclude inactive list values from searches, make sure the Exclude inactive values for List Attributes box is checked.
7 Click Update to update the search.
8 Click Save.
9 Click Return to return to the portlet.

Configuring a Quick Links Portlet
The Quick Links portlet lets you set up a portlet with links to portal pages and external Web sites, including other Web applications. The portlet uses the XML Configuration window to configure the links.
The XML configuration for a Quick Links portlet has the following tags:

<table>
<thead>
<tr>
<th>Tags</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;title&gt;</td>
<td>Portlet header</td>
<td>&lt;title&gt;External Quick Links&lt;/title&gt;</td>
</tr>
<tr>
<td>&lt;links&gt;</td>
<td>Container for links.</td>
<td>&lt;links&gt;</td>
</tr>
<tr>
<td>&lt;link name=...openInNewWindow=...&gt;</td>
<td>Link tag. If you are referencing a portal URL, the openInNewWindow parameter should be set to false (the default). If you are referencing an external URL, the openInNewWindow parameter should be set to true.</td>
<td>&lt;link name=&quot;ViewMyPrograms&quot; openInNewWindow=&quot;false&quot;&gt;&lt;/link&gt; &lt;link name=&quot;Yahoo&quot; openInNewWindow=&quot;true&quot;&gt;&lt;/link&gt;</td>
</tr>
<tr>
<td>&lt;label&gt;</td>
<td>Label or description of the link.</td>
<td>&lt;label&gt;Yahoo&lt;/label&gt;</td>
</tr>
<tr>
<td>&lt;href&gt;</td>
<td>A Web location (URL)</td>
<td>&lt;href&gt;<a href="http://www.agile.com&amp;lt;/href">http://www.agile.com&amp;lt;/href</a>&gt;</td>
</tr>
</tbody>
</table>

Here is an example of a Quick Links XML configuration file with links to several portal URLs:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<links>
  &lt;title&gt;Program Quick Links...&lt;/title&gt;
  &lt;link name="ViewMyPrograms"&gt;
    &lt;label&gt;View My Programs&lt;/label&gt;
    &lt;href&gt;/wps/myportal/viewmyprograms&lt;/href&gt;
  &lt;/link&gt;
  &lt;link name="UpdateTasks"&gt;
    &lt;label&gt;View My Tasks&lt;/label&gt;
    &lt;href&gt;/wps/myportal/updatemytasks&lt;/href&gt;
  &lt;/link&gt;
  &lt;link name="UpdateActionItems"&gt;
    &lt;label&gt;View My Action Items&lt;/label&gt;
    &lt;href&gt;/wps/myportal/myactionitems&lt;/href&gt;
  &lt;/link&gt;
  &lt;link name="CreateProgram"&gt;
    &lt;label&gt;View New Program Creation&lt;/label&gt;
    &lt;href&gt;/wps/myportal/createprogram&lt;/href&gt;
  &lt;/link&gt;
&lt;/links&gt;
```

**Note** In the previous example, “viewmyprograms,” “updatemytasks,” “myactionitems,” and “createprogram” are names that have been mapped internally to portal URLs. For information on how to use URL mapping on your portal, see “Setting Up Quick Links to Portal Pages” below.

Here is another example of a Quick Links XML configuration file, this time with links to several external URLs:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<links>
  &lt;title&gt;Handy Web Links...&lt;/title&gt;
  &lt;link name="Agile" openInNewWindow="true"&gt;
    &lt;label&gt;Agile Software&lt;/label&gt;
    &lt;href&gt;http://www.agile.com&lt;/href&gt;
  &lt;/link&gt;
  &lt;link name="Yahoo" openInNewWindow="true"&gt;
    &lt;label&gt;Yahoo&lt;/label&gt;
    &lt;href&gt;http://www.yahoo.com&lt;/href&gt;
  &lt;/link&gt;
  &lt;link name="Google" openInNewWindow="true"&gt;
```
Setting Up Quick Links to Portal Pages

To set up Quick Links to portal pages, you must first create a URL mapping. URL mapping is a feature of WebSphere Portal Server that allows portal administrators to define simple, easy-to-remember URLs and map them to portal pages. The URL mapping creates a relationship on the portal between a name and a portal page. To create a URL mapping, select Administration > Portal Settings > URL Mapping.

Important The URL mapping must be all lower case.

For more information on how to use URL mapping, see the IBM WebSphere Portal InfoCenter.

Configuring the Report Folder Browser Portlet

The Report Folder Browser portlet lets you generate reports from one of the Report folders. You can configure the portlet to select a particular folder. Once you select a folder, the portlet allows users to navigate to any reports in that folder and any subfolders.

To configure a Report Folder Browser portlet from a portal page:

1. Select a portal page that has the Report Folder Browser portlet.
2. Click the Configure icon (a wrench) for the Report Folder Browser portlet.
   
   Note This folder becomes the topmost folder that users can navigate to when they personalize the portlet.

4. To enable customer external reports to be launched from the portlet, make sure the Enable Customer External Reports box is checked.
5. Click Save to save the configuration.
6. Click Return to return to the portal page.

Using the Portlet Configurator

For Business Object or User Profile portlets, when you configure the portlet an XML Configuration window appears. If you're familiar with XML and XSL (extensible stylesheet language for XML), you may find it easy to edit the XML directly. However, if the XML seems too complicated, use the Portlet Configurator to modify the configuration.
Chapter 3 Configuring Agile Portlets

Figure 3-1: XML Configuration window for a portlet

Note Configuration of the Business Object portlet should be done only by the portal administrator. Consequently, the portal administrator should set resource permissions so that ordinary users do not have permission to personalize the Business Object portlet. For more information about resource permissions, see “Setting Resource Permissions” on page 2-20.

The Portlet Configurator is a Java application that lets you configure Business Object and User Profile portlets using a graphical user interface. Other portlets have simple configuration options, so the Portlet Configurator isn’t needed for them.

The Portlet Configurator connects to the Agile PLM server to read business object classes, attributes, tables and actions. After you specify general portlet properties, the content to use (attribute groups, tables, and actions), and the layout, you can copy the XML configuration data from the Portlet Configurator to the portlet’s XML Configuration window.

Roles and Privileges Needed to Use Agile Portlet Configurator

The Agile Portlet Configurator requires read-access to metadata tables for all Agile PLM classes and subclasses to configure Business Object portlets. Therefore, you should have Administrator privileges to use it. If you don’t have Administrator privileges, see your Agile PLM administrator.

Launching the Agile Portlet Configurator

When you connect to the Agile Portlet Configurator Web site, it uses Java WebStart technology to deploy the application to your computer. After that, you can launch the Portlet Configurator from your computer’s desktop.

Figure 3-2: Portlet Configurator icon on your desktop

---

3-5
You can also launch the Portlet Configurator from the XML Configurator window of a Business Object or User Profile portlet.

To launch the Portlet Configurator from a portlet:

1. Select Administration > Portal User Interface > Manage Pages.
2. Select a portal page that uses Agile portlets.
3. Click the Edit Page Layout icon.
4. Select an Agile portlet, such as one based on the Business Object portlet, and click the Edit Portlet icon.
5. Instead of editing the XML configuration file for the portlet, click the Launch Configurator link.

The Portlet Configurator login dialog box appears. After you log in, the Portlet Configurator appears in its own window.

**Portlet Configurator Toolbar**

The Portlet Configurator has the following toolbar buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Command Equivalent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File &gt; New" /></td>
<td>File &gt; New</td>
<td>Clears any current configuration to create a new configuration. If the previous configuration was not saved, you will be prompted whether to save it.</td>
</tr>
<tr>
<td><img src="image" alt="File &gt; Open" /></td>
<td>File &gt; Open</td>
<td>Opens an existing XML configuration file.</td>
</tr>
<tr>
<td><img src="image" alt="File &gt; Save" /></td>
<td>File &gt; Save</td>
<td>Saves the current configuration to an XML file.</td>
</tr>
<tr>
<td><img src="image" alt="Edit &gt; Copy XML" /></td>
<td>Edit &gt; Copy XML</td>
<td>Copies the XML from the current configuration to the user’s Clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Edit &gt; Paste XML" /></td>
<td>Edit &gt; Paste XML</td>
<td>Pastes XML from the Clipboard to the current configuration. If there is a current configuration, you will be prompted whether to overwrite it.</td>
</tr>
</tbody>
</table>

**Portlet Configurator Tabs**

The Portlet Configurator has three tabs:

- **Classes** – Lets you select the classes and subclasses for the portlet, as well as specify the portlet title
- **Configure** – Lets you define the content and layout of the Business Object portlet.
- **XML** – Lets you view or edit the XML for the portlet configuration.

**Portlet Configurator Navigation**

The Configure tab of the Portlet Configurator has a navigation pane on the left side of the window that lets you quickly switch between the different panes. To switch to a different pane, just click its name in the navigation pane, as shown below.
Using Portlet Configurator to Modify a Configuration

If a Business Object portlet has already been configured, you may want to modify the existing configuration rather than starting over with a new configuration. Use the Copy and Paste buttons to edit the existing configuration in the Portlet Configurator.

To modify an existing portlet configuration:

1. Select a portal page.
2. Click the Configure icon (a wrench) for a Business Object or a User Profile portlet that has already been configured. The XML Configuration window appears.
   
   **Note** If the portlet hasn’t been configured yet, the XML Configuration window is empty.
3. If the portlet has been configured, click Copy to copy the configuration to the clipboard.
4. Click Launch Configurator to start the Portlet Configurator.
5. In the Login dialog box, enter your username, password, and Agile PLM server URL. Click OK.
6. Click Paste.
7. Click the Configure tab.
8. Specify the Content and Layout of the portlet.
9. Click Copy.
   
   **Note** Optionally, you can click Save to save the portlet configuration to an XML file so that you can open it later.
10. Switch to the portlet’s XML Configuration window.
11. Click Paste.
12. Click Save.
13. Click Return to return to the portal page.

Using the Classes Tab

For each Business Object portlet, you must specify the classes and subclasses supported by the portlet. You can also specify a title for the portlet. To set portlet classes and its title, click the Classes tab (by default, the first tab selected). The following options appear:

- **Portlet Title** — The title that appears within the skin of the portlet window. It should identify the type of business object that appears within the portlet.
- **Object Class** — The Agile PLM class used by the portlet. After you select a class, click Add to add it to the Defined Class Views list.
The Business Object portlet supports the following Agile PLM classes:

- Changes
- File Folders
- Items
- Manufacturer Parts
- Manufacturers
- Programs
- Reports
- User Groups

Additionally, the Portlet Configurator allows you to configure the Users class to support the User Profile portlet.

**Note** The actual base classes supported by your Agile PLM system depend on the Agile PLM solutions your company has purchased. However, only the above classes have been certified to be used with Agile portlets.

- **Available Subclasses** – Based on the selected object class, this list shows the available subclasses that can be selected.
- **Selected Subclasses** – Subclasses selected for this portlet. By default, all subclasses are selected. However, you can disable a subclass for the portlet by deselecting it.
- **Defined Class Views** – Lists the object classes that have been added to the portlet configuration.

The following figure shows a portlet that has been configured to support all the subclasses of the Changes class.

![Figure 3-4: Portlet Configurator set to support Changes subclasses](image)

### Using the Configure Tab

The Configure tab is where you specify the content and layout of the portlet for a particular base class. Before you can specify the content and layout, you must select a class in the **Configure for Base Class** list.

![Figure 3-5: Configure for Base Class list](image)
There are three types of content you can specify for the portlet:

- **Attribute Groups** — Sets how Page One, Page Two, and Page Three attributes are grouped within the portlet.
- **Tables** — Sets which tables are used in the portlet, and the columns that appear in each table.
- **Action Groups** — Sets the action buttons that appear in the portlet.

**Attribute Groups**

Business object classes and subclasses can have many attributes visible on Page One, Page Two, and Page Three. Therefore, to provide a more usable portlet interface you should assign the attributes to meaningful groups. The same attribute can appear in multiple groups, if you prefer. To set attribute groups, click **Attribute Groups** in the navigation pane of the Portlet Configurator. The following options appear:

- **Attribute Group Name** — Name of the group of attributes.
- **Display Name as Heading** – Check this box to display the attribute group name as a heading for that area of the portlet.
- **Collapse Group by Default** – Check this box to collapse the attribute group and show only its name. By default, the group is fully expanded.
- **Number of Columns** – Specifies the number of columns used to display the attributes. Select one or two.
- **Filter** – Displays a subset of attributes. Available filters are:
  - All Page One
  - All Page Two
  - All Page Three
  - \(<\text{Subclass}\rangle\) (includes all Page One, Page Two, and Page Three attributes for a particular subclass)
- **Available Attributes** – Displays the list of available attributes based on the currently selected filter.
  
  *Note:* Although the **User Group > Assignment > Date Group Table** attribute is listed in the Available Attributes list, it’s not supported by Agile portlets.
- **Selected Attributes** – Select attribute to add to the attribute group.
- **Add button** – Adds the new attribute group.
- **Update button** – Updates the selected attribute group with the current settings.
- **Delete (X) button** – Deletes the selected attribute group.
The following figure shows an attribute group that has been defined for Page One attributes.

Figure 3-6: Example of a Page One attribute group

![Portlet Configurator](image)

**Tables**

Based on a portlet’s object class, there are several tables you can choose to display in the portlet. You can specify which tables should appear in the portlet and the columns or fields that appear in each table. To configure the content of tables, click **Tables** in the navigation pane of the Portlet Configurator. The following options appear:

- **Choose Table** – Select a table from the list.
- **Display Name** – Name of the table.
- **Display Name as Heading** – Check this box to display the table name as a heading for that area of the portlet.
- **Collapse by Default** – Check this box to collapse the table and show only its name. By default, the table is fully expanded.
- **Available Columns** – Displays the list of available columns based for the selected table.
- **Selected Columns** – Selects columns to add to the table configuration. Columns appear in the portlet in the order they are listed.

  **Note** To change the order of columns, select a column and click ↑ or ↓ to move it up or down.

- **Add button** – Adds the new table configuration.
- **Update button** – Updates the selected table configuration with the current settings.
- **Delete (X) button** – Deletes the selected table configuration.
The following figure shows how the Change Orders.Affected Items table has been configured.

Figure 3-7: Example of Change Orders.Affected Items table configuration

### Action Groups

When you configure a Business Object portlet, you can enable an Actions toolbar with buttons and menu commands for object-level actions. These actions apply to the entire object. You can select which actions are available in the portlet and organize them into functional groups.

The actions that you can select for the portlet depend on the object class. They can include:

- **Common actions** (Bookmark, Delete, New, Print, SaveAs, Send, Subscribe, Edit, CopyToClipboard)
- **Workflow actions** (Approve, Audit Release, Audit Status, Comment, Change Status, and Reject)
- **File Folder actions** (Check In, Check Out, Cancel CheckOut, and Download)
- **Class-specific actions** (such as Incorporate and Unincorporate for Items)
- **Process extensions**

Many of these actions can be grouped together. Two of them, Change Status and New, can only exist in their own action groups.

To define action groups, click *Action Groups* in the navigation pane of the Portlet Configurator. The following options appear:

- **Action Group** – Enter the name of the action group.
- **Number of Actions to Display as Buttons** – Specifies how many actions to display as buttons. If you select 0, all actions will appear in a menu with the same name as the action group. If you select a number greater than 0 but less than the number of actions in the group, the additional actions will be listed in a menu with the name “More.”
- **Available Actions** – Displays the list of available actions for the object class.
- **Selected Actions** – Select actions to add to the group. Actions appear in the portlet in the order they are listed.
  
  **Note** To change the order of actions, select a column and click  or  to move it up or down.
- **Rename** – Renames the selected action. If you change the name of an action, the original Agile name appears to the right of it in parentheses.
❑ **New Action** – Adds a new process extension action to the Available Actions list. For more information, see “Using Process Extensions from within Portlets” on page 3-18.

❑ **Add button** – Adds the new actions group.

❑ **Update button** – Updates the selected action group with the current settings.

❑ **Delete (X) button** – Deletes the selected action group.

The following figure shows an actions group that has been defined for Workflow Actions.

Figure 3-8: Example of a Workflow Actions group

The following figure shows how the Actions toolbar looks in the portlet. Notice that New Object, Change Status, and Common Actions display as drop-down menus, and Workflow Actions only shows two buttons because the **Number Of Actions to Deploy As Buttons** option has been set to 2. The remaining actions in the Workflow Actions group, Audit Release, Audit Status, and Comment, appear on the More drop-down menu.

Figure 3-9: Example of the Actions toolbar

---

**Adding the Edit Action to an Actions Group**

The Edit action is important because it allows users to edit an object that appears in the Business Object portlet. If you don’t add the Edit action to any Actions Groups, the Business Object portlet will be read-only for all users.

Even if the Edit action has been added to Business Object portlet, it may be read-only for some users. Agile PLM privileges determine whether a user has rights to modify an object. If you don’t have the Modify privilege for a particular object, the Edit action is disabled.

**Adding the Change Status Action to an Actions Group**

The Change Status action for routable objects is a special action that behaves differently from other actions. If you add the Change Status action to an action group, it dynamically generates the list of status types from the object class and adds them to the Actions toolbar. However, the workflow status actions replace all other actions you may have selected for that actions group.
If you choose to use the Change Status action, make sure it’s the only action in the group. You can call the group Change Status.

**Adding the New Action to an Actions Group**

The New action allows you to create any of the objects that the portlet supports. The New action appears as a drop-down menu in the Business Object portlet, as shown in Figure 3-10.

![Figure 3-10: New action](image)

The New action cannot be grouped with other actions. It must be the single action added to a group. If you add the New action to a group with other actions, it won’t appear in the portlet.

*Note* The New action is not supported by User Profile portlet and Report objects. Consequently, you can’t use Agile portlets to create users or reports.

When you create a new object within the Business Object portlet, the portlet usually displays a New Object dialog box with the fields needed to define the new object (such as the subclass and object number), as shown in Figure 3-11.

![Figure 3-11: New Object dialog box](image)

If the portlet supports only one subclass and one autonumber sequence and an autonumber is required, the New Object dialog box doesn’t appear and the object is created using the next autonumber.

**Portlet Layout**

After specifying the properties and content of a Business Object portlet, you can configure the portlet layout. To define the layout, click **Layout** in the navigation pane of the Portlet Configurator. The Layout window allows you to:

- Construct a portlet header.
- Select the layout template to be used.
- Arrange the attribute groups and tables within the layout.

The following options appear in the Layout window:

- **Display Object Status** – Check this box to display the object’s status at the top right of the portlet. If the Actions toolbar is shown, the status appears below it.
- **Use Portlet Header** – Check this box to display a custom header at the top left of the portlet. If the Actions toolbar is shown, the portlet header appears below it.
- **Construct Header** – Use the list of attributes to the right to add Page One attributes to the header. In that way, you can display the object’s Number, Description, Status, or other Page One attributes in the header. You can also type attributes directly in the field, such as \[Number\]: \[Description of Change\].
- **Add** – Adds the selected Page One attribute to the portlet header.
Define Layout For – Select the object class for which you wish to define a layout. The Default layout applies to the object class and all its subclasses. You can also define layouts that are subclass-specific. For example, you can define a Default layout for the Changes object class, but define a separate layout for the ECO subclass.

Layout Template – Select either the Form or Tabbed layout template.

Available Attribute Groups – Select an attribute group and click > to add it to a form or tab.

Available Tables – Select a table and click > to add it to a form or tab.

Form – If you chose the Form layout template, use the form to arrange attribute groups and tables.

Tab Name – Type the name of a tab name to use, and click Add to add it to the Tabs box.

Tabs – If you chose the Tabbed layout template, use the different tabs to arrange attribute groups and tables.

Add >> – Adds the configuration to the layout.

Update >> – Updates the configuration of the layout.

Defined Layouts – Displays the layouts that have been defined for each object class. Select one to edit it.

Note Attribute groups always display first, followed by tables, in both the Form or Tabbed layout. This is true even if you move a table above an attribute group in the list.

The following figure shows the configuration for a tabbed layout.

Figure 3-12: Example of a tabbed layout
The following figure shows the configuration for a form layout.

Figure 3-13: Example of a form layout

![Portlet Configurator](image)

**Messaging Between Portlets**

The `portlet.messaging` parameter of a portlet allows you to define how a portlet updates itself, the page, or other portal pages. Objects that are listed in Agile portlets—such as in a Search Results portlet—appear as standard links. When you click an object link, the portlet sends a message to its intended target. The target can be the same portlet, the page on which the portlet appears, or another page specified by its URL mapping. The context of the object that you've clicked is sent to the target, which causes it to be updated.

When you modify a portlet's `portlet.messaging` parameter, you can specify the following values:

- an empty string ("") – uses the default portlet messaging.
- page – updates the current page.
- none – does not send a message to other portlets. In other words, object links in the portlet appear as normal text.
- an internal portal URL – updates another page specified by URL mapping. The URL must be all lower case.

**Important** Changes to the `portlet.messaging` parameter do not take effect until you log out of the portal and log in again (to clear the cache).

If the `portlet.messaging` parameter is missing from a portlet or the parameter value is a null string, the portlet uses the default portlet messaging behavior. For objects supported by the Business Object portlet, the portlet overrides the `portlet.messaging` parameter and always messages to itself. For objects that aren’t supported by the Business Object portlet, the default behavior is for the portlet to send a message to the page.

If you want the Business Object portlet to message to other portlets on the same page when you click a link for a particular class of objects, make sure

- the `portlet.messaging` parameter for the Business Object portlet is set to page

- the Business Object portlet is NOT configured to support the class. If the Business Object portlet supports a class, it will always message to itself when you click a link for an object of that class.

For more information on how to set portlet parameters, see “Setting Agile Portlet Parameters” on page 2-13.
Clearing Portlets If Messaging Is Not Supported

The `clearPortletContentsIfMessageNotSupported` parameter can be used to clear the contents of a portlet if a message received from another portlet (such as a Search portlet) is not supported. Use the `clearPortletContentsIfMessageNotSupported` parameter in conjunction with the `portlet.messaging` parameter to determine how portlets get updated when you click a link in them.

For example, let's create a portal page with the following portlets:

- Advanced Search
- Search Results
- Business Object Portlet - Changes (a copy of the Business Object portlet that supports only Changes)
- Business Object Portlet - Items (a copy of the Business Object portlet that supports only Items)

Specify the following portlet parameters:

<table>
<thead>
<tr>
<th>Portlet</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Results</td>
<td><code>portlet.messaging</code></td>
<td>page</td>
</tr>
<tr>
<td>Business Object Portlet - Changes</td>
<td><code>clearPortletContentsIfMessageNotSupported</code></td>
<td>true</td>
</tr>
<tr>
<td>Business Object Portlet - Items</td>
<td><code>clearPortletContentsIfMessageNotSupported</code></td>
<td>true</td>
</tr>
</tbody>
</table>

The following figures illustrate a sequence showing how the page is updated when you click different object links in the portlets.

Figure 3-14: Search for an ECO, then click a result.

Click here to open the ECO in the Changes portlet
Exporting and Importing Portal Configurations using the XML Configuration Interface

WebSphere Portal Server provides an XML configuration interface that allows you to configure the portal remotely. The XML configuration interface is a command line tool that connects to the server using an HTTP connection. You can use the tool to export the portal settings from a test server and import them to a production server. The command line client is located in the `<wps_root>`\bin folder. To invoke the client, use the xmlaccess.bat script.

The syntax for the xmlaccess command is as follows:

```
xmlaccess -in XML_file -user user -pwd password -url PortalConfigURL -out filename.xml
```

**Note** You can specify the command options in any sequence.

The xmlaccess command can be used to:
- Transfer a complete portal configuration
- Transfer a portal page
Agile PLM 9.1

- Transfer a portal page and its portlets
- Create and modify resources
- Perform administration tasks

For more information about the WebSphere Portal Server XML configuration interface, see the IBM WebSphere InfoCenter.

To export the WebSphere Portal Server configuration:

1. In a command prompt window, go to the location of the XML Configuration Interface:
   ```
cd <drive>:<wps_root>\bin
   ```
2. Run the following `xmlaccess` command to export the entire portal configuration to a file called Complete.xml:
   ```
   xmlaccess.bat -in ../doc/xml-samples/Export.xml -user wpsadmin -pwd wpsadmin
   -url http://hostname:9081/wps/config -out Complete.xml
   ```
   You can use the resulting output file as the input parameter for the `xmlaccess` command to import the portal configuration on another portal server.

To import the WebSphere Portal Server configuration on another server:

1. Copy the latest AgilePortletPack2.war file to the `<wps_root>\installableApps` folder of the target server.
2. In a command prompt window, go to the location of the XML Configuration Interface:
   ```
cd <drive>:<wps_root>\bin
   ```
3. Run the following `xmlaccess` command to import the portal configuration from the Complete.xml file that you previously exported:
   ```
   xmlaccess.bat -in Complete.xml -user wpsadmin -pwd wpsadmin
   -url http://hostname:9081/wps/config -out Out.xml
   ```
   **Note** If the target server has a different portal administrator than the one used to export the Complete.xml file, edit the file and change the `user` and `pwd` parameters.

Using Process Extensions from within Portlets

Agile PLM 9.2.1 includes a special web service that lets you invoke Agile PLM process extensions from within a portlet. The web service is contained in a file named PXWebService.jar, which is installed in the following folder on the Agile PLM server:

  `<agile_home>\integration\sdk\extensions`

For more information about how to develop and deploy process extensions, see the *Agile SDK Developer Guide*.

To configure your portal to use process extensions:

1. Before using a process extension from within a portlet, check to make sure PXWebService is working. Open a browser and type the following URL:
   ```
   http://<server>:<port>/<virtualPath>/integration/ws/InvokePX?wsdl
   ```
   For example, if you installed Agile PLM on a server named plmserver, you’re hosting Agile PLM on Oracle Application Server using port 7777, and you’re using a virtual path named “Agile,” type the following URL:
   ```
   ```
   You should see a WSDL response in the browser. If you don’t, the web service may not have been deployed properly. Make sure you installed the latest Agile PLM service packs. For more information about how to check whether Agile PLM web services are working, see the Agile PLM installation guide.
2 Make sure that the `webClientVirtualPath` portlet application parameter has been configured correctly. This should be the same as the URL used to access the Agile Web Client, but without the trailing “/PLMServlet”. For more information, see “Setting Agile Portlet Services Application Parameters” on page 2-6.

3 Portlets use Basic Authentication to invoke the PXWebService on the Agile PLM server. Make sure the Web server used by your WebSphere Portal has Basic Authentication enabled. In Internet Information Server, you can enable Basic Authentication from the Directory Security tab.

### Configuring a New Process Extension Action for a Portlet

When you use the Portlet Configurator to configure a portlet, you can select the actions that appear at the top of the portlet. In addition to standard actions, like Bookmark, Delete, Print, and SaveAs, you can add custom actions that invoke process extensions.

**To configure a new process extension action:**

1. Configure a portlet based on the Business Object portlet.
2. In the XML Configurator window, click the Copy button to copy the configuration to the Clipboard.
3. Click the Launch Configurator link to open the Portlet Configurator window.
4. In the Portlet Configurator Login dialog box, enter your username, password, and the Agile PLM server URL. Click OK to log in.
   
   The Portlet Configurator window appears.
5. Click Paste.
6. Click the Configure tab.
7. In the navigation pane, click Action Groups.
8. Click the New Action button.
9. In the Action Name field, type a name for the custom action.
10. In the Process Extension field, select a valid process extension.

   **Note** The Portlet Configurator displays all process extensions, not just the ones that have been assigned to a particular class. Only process extensions that have been assigned to the class are valid.

11. If you selected a URL-based process extension (one that links to another Web page or a Web-based application), check the Refresh Parent box if you want the parent portlet to be refreshed after you close the process extension page. If the process extension updates the object that launched the page, you can use this option to refresh the portlet.
12. You can now include the custom action in any Action Group.

   **Note** In the XML, the process extension action looks like any other action but has the ref-id "%common.invokePX". Do not modify the ID of this process extension action.

### Testing a Sample Process Extension within a Portlet

The Agile SDK includes a sample process extension, SamplePXes.jar. To obtain the source code for SamplePXes.jar and other Agile SDK sample programs, download the Developer Documentation Installer from the Agile Documentation Web Site (http://docs.agile.com). Follow the instructions in the Agile SDK Developer Guide to build and deploy SamplePXes.jar in the `<agile_home>/integration/sdk/extensions` folder. You also need to configure the “Set Description” process extension using the Agile Java Client.
To test the Set Description process extension from within a portlet:

1. Build and deploy the sample process extensions included with the Agile SDK.
   a. Download the Java SDK from http://java.sun.com/ and install it on your development machine.
   b. Set the system variable JAVA_HOME to point to the home directory of your Java SDK installation.
   c. Download the Ant build tool from http://ant.apache.org/ and install it on your development machine.
   d. Set the system variable ANT_HOME to point to the home directory of your Ant installation.
   e. Open a command prompt window and go to the Process Extensions samples folder located in
      `<agile_home>/integration/sdk/samples/px`.
   f. Type the following command to build the samples:
      ```
      %ANT_HOME%\bin\ant all
      ```
      Ant uses the build.xml file to build the SamplePXes.jar file and then deploy it to the
      `<agile_home>/integration/sdk/extensions` folder, where all process extensions and web service extensions are
      automatically deployed for clients that invoke them.

2. Enable the Set Description process extension.
   a. Log into Java Client as an administrator.
   b. Choose Settings > Data Settings > Process Extensions.
   c. Click the New toolbar button. The Add Process Extension dialog box appears.
   d. For Type, select Internal Custom Action.
   e. For Internal Custom Action, select samplepx.SetDescription.
   f. Enter values in the following fields:
      • Name – Enter “Set Description.”
      • Description – Enter “Sets the description of the object.”
      • Initiate From – Select “Actions menu.”
      • Roles – Select one or more roles to use for the process extension. To use the roles and privileges of the
        current user, leave the field blank.
      • Timeout – Use the default value (60 seconds).
      • Enabled – Select Yes.
   g. Click OK.

3. Add the Set Description process extension to the Item class.
   a. In Java Client, choose Settings > Data Settings > Classes.
   b. Open the Items class.
   c. Click the Process Extensions tab.
   d. Click the Assign toolbar button.
   e. Select the “Set Description” process extension, and then click > to move it into the selected list.
   f. Click OK.

4. In the Portlet Configurator, add the Set Description process extension as a custom action and assign it to the Item
   class.
   a. Edit a portal page that has an Item Portlet, that is, a Business Object portlet configured for the Items class.
   b. In the XML Configurator window, click the Copy button to copy the configuration to the Clipboard.
Chapter 3 Configuring Agile Portlets

c Click the Launch Configurator link to open the Portlet Configurator window.

d In the Portlet Configurator Login dialog box, enter your username, password, and the Agile PLM server URL. Click OK to log in.

The Portlet Configurator window appears.

e Click Paste.
f Click the Configure tab.
g In the navigation pane, click Action Groups.
h In the Action Groups field, type “Custom Actions”.
i Click the New Action button.
j For Action Name, type “Set Description.”
k For Process Extension, select “Set Description.”
l Click OK.
m Select the “Set Description” action, and then click the > button to move it into the Selected Actions list.
n Click the Add button to move “Set Description” into the Custom Actions action group.
o Click Copy.
p Switch to the XML Configuration window, and click Paste.
q Click Save to save the configuration.
r Click Return to return to the portlet page.

5 Invoke the Set Description process extension and verify that the Item Description is now assigned to a random value.

a Open a portal page that has the Item Portlet.
b Search for or select an item to display data in the Item Portlet.
c Choose Custom Actions > Set Description.

You should see the new value in the Description field.

Creating Custom Help for Agile Portlets

Because Agile portlets are so flexible and customizable, static online help files are not provided with them. However, you can create your own custom online help files. You can choose one of two online help scenarios for each Agile portlet:

Using Relative References to Help Files

With this scenario, all Agile portlets share the same base URL for help files. To specify the base URL, enter the help.base.url application parameter. For each portlet, enter a value for the help.relativePath portlet parameter, which specifies the relative path to a help file. The help handler for Agile portlets combines the base URL and the relative URL to form the complete URL to the help file.

For example, if the help.base.url value is http://webserver/portlethelp, the help.relativePath for the Advanced Search portlet could be AdvancedSearch.html. The complete URL that is used to access the file is http://webserver/portlethelp/AdvancedSearch.html.

Using Absolute References to Help Files

With this scenario, each portlet specifies its own help file. You can use the help.url portlet parameter to override the help.base.url application parameter and the help.relative.path portlet parameter.
For example, if you created help for the Advanced Search portlet and deployed it on a Web server named “portal”, the help.url value could be http://portal/docfiles/AdvancedSearch.html.

Note If there is a value in a portlet’s help.url parameter, it overrides the help.relativePath portlet parameter and the help.base.url application parameter.

**Downloading Online Help Files for Agile Portlets**


To configure Agile portlets to use the downloaded online help files:

1. Download the help archive file for Agile portlets.
2. Extract all files from the help archive file.
3. Create a folder called AgilePortletHelp in your Web server’s docroot directory.
4. Copy the portlet help files to the AgilePortletHelp folder.
5. Set the help.base.url application parameter for AgilePortlets 2.1 to the URL for the AgilePortletHelp folder (for example, http://<webserver>/AgilePortletHelp). For complete instructions, see “Setting Agile Portlet Services Application Parameters” on page 2-6.

**Configuring Online Help for Portlets on WebSphere Portal 5.1.0.2**

If you want to create custom online help files for Agile portlets on WebSphere Portal 5.1.0.2, follow these instructions.

To configure Agile portlets to use a base help URL on WebSphere Portal 5.1.0.2:

1. Set the help.base.url application parameter for AgilePortlets 2.1. For complete instructions, see “Setting Agile Portlet Services Application Parameters” on page 2-6.
2. Click Portlet Management > Portlets.
3. Select an Agile portlet, and click the Configure Portlet icon.
4. For the help.relativePath parameter, click the Edit Parameter icon.
5. In the Value box, enter a URL that is relative to the help.base.url setting for Agile portlets. For example, the value could be an HTML filename.
6. Click OK.
7. Select other Agile portlets and configure their help.relativePath parameter in the same way.

To configure an Agile portlet to override the base help URL and use its own help URL on WebSphere Portal 5.1.0.2:

1. Log into the WebSphere Portal Server as a portal administrator.
2. Click Administration.
3. Click Portlet Management > Portlets.
4. For the help.url parameter, click the Edit Parameter icon.
5. In the Value box, enter a help URL.
6. Click OK.
Configuring Online Help for Portlets on WebSphere Portal 5.022

If you want to create custom online help files for Agile portlets on WebSphere Portal 5.0.2, follow these instructions.

To configure Agile portlets to use a base help URL on WebSphere Portal 5.022:

1. Set the `help.base.url` application parameter for AgilePortlets 2.1. For complete instructions, see “Setting Agile Portlet Services Application Parameters” on page 2-6.
2. Click **Portlets > Manage Portlets**.
3. Select an Agile portlet, and click **Modify Parameters**.
4. Enter a URL that is relative to the `help.base.url` setting for Agile portlets. For example, the value could be an HTML filename.
5. Click **Save**.
6. Select other Agile portlets and configure their `help.relativePath` parameter in the same way.

To configure an Agile portlet to override the base help URL and use its own help URL on WebSphere Portal 5.022:

1. Log into the WebSphere Portal Server as a portal administrator.
2. Click **Administration**.
3. Click **Portlets > Manage Portlets**.
4. Select an Agile portlet, and click **Modify Parameters**.
5. Enter a value in the `help.url` parameter.
6. Click **Save**.
This chapter describes the features of Agile portlets. It includes the following topics:

- Agile Portlet Features
- Using Edit Mode to Personalize Agile Portlets
- Filtering Data in Portlets
- Advanced Search Portlet
- Attachment Files Portlet
- Bookmarks Portlet
- Business Object Portlet
- Clipboard Portlet
- My Notifications and Requests Portlet
- My Things To Do Portlet
- Quick Links Portlet
- Quick Navigation Portlet
- Quick Search Portlet
- Report Folder Browser Portlet
- Saved Search Portlet
- Search Folder Browser Portlet
- Search Results Portlet
- Single Signon Portlet
- Upload File Portlet
- User Profile Portlet
- Sending Portlet Errors to the Portal Administrator

### Agile Portlet Features

Each Agile portlet is a small Web-based application that connects to the Agile server and displays data in tabular format. For example, Find portlets like the Quick Search portlet display a table of search results after you click the Search button.

If you click an object’s number link in an Agile portlet, you load data in other Agile portlets, like a Business Object portlet.
Many of the Agile portlets have common controls that let you refresh data from the server or view an object in the Agile Web Client. Several Agile portlets let you perform relevant actions—such as Bookmark or Subscribe—for each object listed in the portlet.

To refresh the data in an Agile portlet:
Click  

**Using Edit Mode to Personalize Agile Portlets**

Portal users can personalize Agile portlets to change the display to their own personal preference. When you personalize a portlet, it affects the portlet only for you, not for other users.

The following Agile portlets can be personalized:
- Advanced Search
- Attachment Files
- Business Object
- My Notifications and Requests
- My Things To Do
- Quick Links
- Report Folder Browser
- Saved Search
- Search Folder Browser
- Single Signon
- User Profile

Most portlets have a simple Edit mode user interface to personalize the portlet. The Business Object and User Profile portlets both use the XML Configuration window for Edit mode, but they also allow you to launch the Portlet Configurator to personalize those portlets. The Quick Links portlet uses only the XML Configuration window for personalization. If you are not proficient at editing XML, don’t attempt to personalize the Quick Links portlet.

To use Edit mode to personalize an Agile portlet:
1. Select a portal page.
2. Click the **Edit** icon (a pencil) for a portlet.
3. Edit the configuration.
   - For some portlets, you can click **Use Defaults** to revert to the default configuration specified by the portal administrator.
4. Click **Save**.
5. Click **Return** to return to the portlet.

**Filtering Data in Portlets**

The following Agile portlets provide a filter bar that lets you filter out data from tables:
- My Things To Do
- My Notifications and Requests
- Saved Search
- Search Results
To use the filter bar, select an attribute from the list, type a value, and then click Filter. To show all rows in the table, click Show All.

Figure 4-1: Filter bar

Advanced Search Portlet

The Advanced Search portlet searches for all objects with fields that match the conditions of the search. The portlet must be configured properly before it can be used on a page. The fields and attributes that you can use in an advanced search depend on the class that the portlet is configured to search. After you specify the search conditions, click Search.

Figure 4-2: Advanced Search portlet

Using Advanced Search

The Advanced Search portlet can be personalized to search on multiple attributes for a particular class. Each attribute appears in the Advanced Search portlet as a separate search condition. For each search condition, specify a value.

The following figure shows the Advanced Search portlet configured to show multiple attributes.

Figure 4-3: Multiple Advanced Search attributes
The relational operator used for each search condition depends on the data type of its attribute, as shown in the following table.

### Table 4-1: Relational operators used in Advanced Search

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Relational Operator</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Contains or Like</td>
<td>Specify a text value. When you type a word to search for, it’s searched using the Contains relational operator. That means the search finds all objects that contain the word in that field. You can also use wildcard characters (<em>) and (?) in the search value, in which case the Like operator is used. Agile supports two wildcards: the asterisk (</em>) and the question mark (?). The question mark finds matches with any other single character. For example, *at finds hat, cat, and fat, but not splat. The asterisk finds matches with more than one character. For example, *at finds cat, splat, and big hat. The asterisk by itself finds all objects of the specified class. <strong>Note:</strong> If you use wildcards, try to make your search as narrow as possible. Otherwise, the search may not be able to return results because it matches too many rows in the database.</td>
</tr>
<tr>
<td>Multitext</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>Greater Than or Equal To, Less Than or Equal To, or Between</td>
<td>Specify starting and ending date values. The relational operator used in the search depends on the range of dates you specify. If you specify only the starting date, the search finds any date values that are greater than or equal to it. If you specify only the ending date, the search finds any date values that are less than or equal to it. If you specify both the starting and ending dates, the search finds any date values that fall within the specified range.</td>
</tr>
<tr>
<td>List</td>
<td>Equal To</td>
<td>Select one or more list values. If you select multiple list values, the search constructs multiple search conditions in the background and connects them using the OR logical operator. For example, if you select “Production, Prototype” for the Lifecycle Phase attribute (as shown above), the search returns items whose Lifecycle Phase is equal to “Production” or “Prototype”.</td>
</tr>
<tr>
<td>Money</td>
<td>Equal To</td>
<td>Specify a numeric value to search, not a currency code. When you run the search, money values are converted to the company’s corporate currency to determine if they match the value you specified.</td>
</tr>
<tr>
<td>MultiList</td>
<td>Contains</td>
<td>Select one or more list values. The search finds any matches that contain any of the specified list values, not all of them. If you select multiple list values, the search constructs multiple search conditions in the background and connects them using the OR logical operator. For example, if you select “Equipment, PDA” for the Product Line(s) attribute (as shown above), the search returns items whose Product Line(s) field contains “Equipment” or “PDA”.</td>
</tr>
<tr>
<td>Numeric</td>
<td>Equal To</td>
<td>Specify a numeric value to search.</td>
</tr>
<tr>
<td>UOM</td>
<td>Equal To</td>
<td>Specify a numeric value, not a unit of measure. For example, if the value you are searching for is “5.0 Gram”, type “5” or “5.0”.</td>
</tr>
</tbody>
</table>

The logical operator AND is used between multiple search conditions that you specify. For example, in the Advanced Search screen shown in Figure 4-3, the following logic applies:

```
Search for Items where
  [Title Block.Number] is Like P0017* AND
  [Title Block.Description] Contains BOARD AND
  ([Title Block.Lifecycle Phase] is Equal To "Production" OR
  [Title Block.Lifecycle Phase] is Equal To "Prototype") AND
  ([Title Block.Product Line(s)] Contains "Capricorn" OR
  [Title Block.Product Line(s)] Contains "Leo") AND
  [Title Block.Rev incorp Date] is Between 02/01/06 and 05/01/06
```

When you finish specifying values to search for, click **Search**.

To save your search so you can reuse it later, click **Save Search**.

To clear search criteria and start a new search, click **Clear**.
OR Searches
To do an “or” search, type two words separated by a space. For example, “FUSE TRANSISTOR” will find all objects that contain either “FUSE” or “TRANSISTOR” in that field.

AND Searches
To do an “and” search, type a second word prepended with a plus sign. For example, “INTEL +PENTIUM” will find all objects that contain both “INTEL” and “PENTIUM” in that field.

Note Do not put a space between the plus sign and the second word. For example, “INTEL + PENTIUM” is not a valid search value.

AND NOT Searches
To do an “and not” search, type a second word prepended with a minus sign. For example, “INTEL -PENTIUM” will find all objects that contain “INTEL” but not “PENTIUM” in that field.

Matching Exact Phrases
To do an “exact match” search, type a word or phrase surrounded by quotes. For example, “LOAD BALANCER” will find all objects that contain the exact phrase “LOAD BALANCER” in that field.

You can’t combine “exact match” searches with “and” or “or” searches. For example,

“LOAD BALANCER” +IBM

is not a valid search value.

Personalizing the Advanced Search Portlet
The Advanced Search portlet has slightly more complex Edit mode options than other Agile portlets. You can select one of the defined searches, and specify the search fields and output fields.

To personalize the Advanced Search portlet:
1. Select a portal page with the Advanced Search portlet, and click the pencil icon to enter Edit mode.
2. Select one of the defined searches.
3. Select fields to search, and then click the right arrow to move them into the Selected Attributes box.
4. Select search output fields, and then click the right arrow to move them into the Selected Attributes box.
5. To remove a field from either of the Selected Attributes lists, select it and then click the left arrow.
6. Click Update to update the search.
7. Click Return to return to the portlet.
**Edit Mode Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Select Search</td>
<td>Select one of the predefined searches.</td>
</tr>
<tr>
<td>2 - Select Fields to Search</td>
<td>Select search attributes by moving them into the Selected Attributes list.</td>
</tr>
<tr>
<td>3 - Select Search Output</td>
<td>Select attributes that appear in the search results. Move attributes from</td>
</tr>
<tr>
<td>Fields</td>
<td>the Available Attributes list to the Selected Attributes list. You can also</td>
</tr>
<tr>
<td></td>
<td>sort attributes by moving them up or down in the Selected Attributes list.</td>
</tr>
<tr>
<td>4 - Update</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving. To save the configuration, make sure</td>
</tr>
<tr>
<td></td>
<td>you click Update first.</td>
</tr>
<tr>
<td>Use Default Configuration</td>
<td>Uses the default search criteria.</td>
</tr>
</tbody>
</table>

**Configure Mode Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Class to Search</td>
<td>Select the class used to search for objects.</td>
</tr>
<tr>
<td>Define Search For</td>
<td>Select the class you are defining search criteria for.</td>
</tr>
<tr>
<td>Select the Attributes to Include</td>
<td>Select attributes that users can use to search. Move attributes from the</td>
</tr>
<tr>
<td>as “Advanced” Search Parameters</td>
<td>Available Attributes list to the Selected Attributes list. You can also</td>
</tr>
<tr>
<td></td>
<td>sort attributes by moving them up or down in the Selected Attributes list.</td>
</tr>
<tr>
<td>Select Attributes to Display in the</td>
<td>Select attributes that appear in the search results. Move attributes from</td>
</tr>
<tr>
<td>Search Results</td>
<td>the Available Attributes list to the Selected Attributes list. You can also</td>
</tr>
<tr>
<td></td>
<td>sort attributes by moving them up or down in the Selected Attributes list.</td>
</tr>
<tr>
<td>Add or Update</td>
<td>Creates or updates the search definition.</td>
</tr>
<tr>
<td>Exclude Inactive Values for List</td>
<td>To exclude any inactive list values from search results, make sure this</td>
</tr>
<tr>
<td>Attributes</td>
<td>box is checked.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
</tbody>
</table>

**Attachment Files Portlet**

Shows a selected object’s Attachments table. To use the Attachment Files portlet, you must first use one of the Search portlets to find an object with an Attachments table, such as an item or change. You can use the Attachment Files portlet to open, download, add, checkout, cancel checkout or check-in a file, as well as click a file to view it in the Agile Viewer.
To display the attachments table, select values for the Site and Rev. By default, the portlet shows all sites and the Introductory revision.

**Edit Mode Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Attributes</td>
<td>Lists available attributes for the table.</td>
</tr>
<tr>
<td>Selected Attributes</td>
<td>Lists attributes you selected.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
<tr>
<td>Use Defaults</td>
<td>Uses the default configuration.</td>
</tr>
</tbody>
</table>

**Configure Mode Options**

Configure mode has the same options as Edit mode, except it does not have the **Use Defaults** option. See “Edit Mode Options” above. When you save settings in Configure mode, they become the default settings for the portlet.

**Bookmarks Portlet**

Shows the current user’s Agile PLM bookmarks. You can define new Agile PLM bookmarks from Agile PLM clients, including the following Agile portlets:

- Business Object
- Saved Search
- Search Results

Agile Bookmarks are also listed in the Quick Navigation portlet.

To delete a bookmark, select it and click **Delete**.

Figure 4-5: Bookmarks portlet
Business Object Portlet

Shows data for Agile PLM business objects (such as items or change orders). Easily the most powerful and most customizable of Agile’s portlets, the Business Object portlet allows you to create portlets that display different types of Agile PLM business objects. The Business Object portlet can be configured to support multiple object classes. You can use the Portlet Configurator to customize the content and layout of the portlet, selecting the presentation of data appropriate for your users.

The Business Object portlet supports the following Agile PLM classes:

- Changes
- File Folders
- Items
- Manufacturer Parts
- Manufacturers
- Programs
- Reports
- User Groups

Additionally, the Portlet Configurator allows you to configure the Users class to support the User Profile portlet.

Other portlets, such as the Search Results portlet, can message to the Business Object portlet to update its content when you click an object link. After you view a series of different objects in the Business Object portlet, you can use the “breadcrumbs” feature at the top of the portlet to backtrack to previously viewed objects.

For information on how to use the Portlet Configurator to configure the Business Object portlet, see “Using the Portlet Configurator” on page 3-4.
**Note** To add a file attachment to an object displayed in the Business Object Portlet, make sure you have Modify privileges to the File Folder’s **Title Block > Description** field.

### Clipboard Portlet

Lets you collect Agile PLM objects to later perform actions on them.

*Figure 4-8: Clipboard portlet*

The Clipboard is a temporary storage portlet for the user’s current portal session. Each user can store different things in the Clipboard. You can manage the list of objects in the Clipboard to quickly retrieve objects. When you first log in, the Clipboard is empty. When you add objects to the Clipboard, they remain there until you empty the Clipboard, click **Remove** or **Empty** to remove them, or terminate the portal session.

Don’t confuse the Clipboard portlet with the Windows Clipboard. You can’t use the Clipboard portlet to copy and paste objects to the Windows Clipboard. It’s used only to copy and paste objects between Agile portlets.

You can add objects to the Clipboard from other Agile portlets. Select one or more rows and then choose the Copy To Clipboard action.

On any editable table in the Business Object portlet, you can use the **Clipboard > Paste** action to paste the contents of the Agile Clipboard into the table. Although the Agile Clipboard may contain disparate objects (such as Items and Changes), only objects supported by the table are pasted.

**Note** You don’t need to place the Clipboard portlet on a portal page to take advantage of the Clipboard functionality available in other Agile portlets.

### My Notifications and Requests Portlet

Shows the current user’s notifications and requests. Notifications and Requests appear as separate views in the portlet (although the portal administrator can choose to not display both).

*Figure 4-9: My Notifications and Requests portlet*
If you click a Subject link in the My Notifications and Requests portlet, the portlet displays a detail view of the notification or request, as shown below.

Figure 4-10: My Notifications and Requests portlet - detail view

The table actions available in the My Notifications and Requests portlet vary based on the view that’s selected.

Table 4-2: My Notifications and Requests table actions

<table>
<thead>
<tr>
<th>View</th>
<th>Available Table Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Notifications</td>
<td>Delete, XLS (Save Table to Excel)</td>
</tr>
<tr>
<td>My Notifications - Detail</td>
<td>Delete</td>
</tr>
<tr>
<td>My Requests</td>
<td>Accept, XLS (Save Table to Excel)</td>
</tr>
<tr>
<td>My Requests - Detail</td>
<td>Delete, Reject</td>
</tr>
</tbody>
</table>

**Configure Mode Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Views</td>
<td>Lists available views for the portlet:</td>
</tr>
<tr>
<td></td>
<td>• My Notifications</td>
</tr>
<tr>
<td></td>
<td>• My Requests</td>
</tr>
<tr>
<td>Selected Views</td>
<td>Lists views you have selected.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
</tbody>
</table>

**My Things To Do Portlet**

Shows objects routed to the current user that he must act on. The My Things To Do portlet consolidates Action Items, Workflow Routings, and Program Activities within one portlet (although the portal administrator can choose to not display all three views). You can update your assignments by marking them complete or entering a completion percentage.
Figure 4-11: My Things To Do portlet

The table actions available in the My Things to Do portlet vary based on the view that’s selected.

Table 4-3: My Things to Do table actions

<table>
<thead>
<tr>
<th>View</th>
<th>Available Table Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Action Items</td>
<td>Accept, Decline, Mark Complete, Edit, XLS (Save Table to Excel)</td>
</tr>
<tr>
<td>My Workflow Routings</td>
<td>XLS (Save Table to Excel)</td>
</tr>
<tr>
<td>My Program Activities</td>
<td>Edit, XLS (Save Table to Excel)</td>
</tr>
</tbody>
</table>

Displaying Things To Do by Due Date

You can display Action Items or Program Activities based on the date they are due. Click the Display Due In list and select All, 1 Week, 2 Weeks, 1 Month, 2 Months, or 6 Months.

Configure Mode Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Views</td>
<td>Lists available views for the portlet:</td>
</tr>
<tr>
<td></td>
<td>• My Action Items</td>
</tr>
<tr>
<td></td>
<td>• My Workflow Routings</td>
</tr>
<tr>
<td></td>
<td>• My Activities</td>
</tr>
<tr>
<td>Selected Views</td>
<td>Lists views you have selected.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
</tbody>
</table>

Quick Links Portlet

Lets you add links to other portal pages or to external Web pages. When you click a link, the page can display within the portal or it can open within a new browser window.

Figure 4-12: Quick Links portlet

You can use the Quick Links portlet to provide users a quick way to navigate to a page for information on how to complete a task, or provide a link to another Web application.
Edit Mode Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the XML configuration.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the XML configuration.</td>
</tr>
<tr>
<td>XML Configuration</td>
<td>Defines the XML configuration for the portlet. For more information, see “Configuring a Quick Links Portlet” on page 3-2.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
<tr>
<td>Use Defaults</td>
<td>Uses the default configuration.</td>
</tr>
</tbody>
</table>

Configure Mode Options

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option. When you save settings in Configure mode, they become the default settings for the portlet. See “Edit Mode Options” above.

Quick Navigation Portlet

Lets you navigate to bookmarked or recently visited Agile PLM objects, or objects that you copied to the Clipboard portlet.

- **Recently Visited** – During each Agile PLM session, the server maintains a list of the last 10 objects viewed (or 25, 50, or 100, depending on the server’s Preference settings).

- **Bookmarks** – Agile PLM clients, including portlets, allow you to bookmark objects to later return to them quickly.

  **Note** The Bookmarks portlet also lists Agile PLM bookmarks.

- **Clipboard** – Collects Agile PLM objects to later perform actions on them. You can use the Agile Clipboard (not to be confused with the Windows Clipboard) to copy and paste objects between Agile portlets.

If you click an object link in the Quick Navigation portlet, it automatically updates the object reference for portlets on the current page. Because the Quick Navigation portlet does not have aportlet.messaging parameter, you can’t configure it to update the object reference for portlets on other pages.
Quick Search Portlet

Searches for Agile PLM objects by specifying a single matching value.

The Quick Search portlet lets you quickly locate objects in the Agile system that match the text you enter. The text must be the start of the ID number you are seeking or the beginning of a word within the object’s description. Quick Searches are not case sensitive.

Select a class to search. Type the value to search for, and then click Search. The results appear in the Search Results portlet.

Note: For Quick Searches, the display fields that appear in the Search Results cannot be configured.

To perform a full-text search of files listed on the Attachments tab of objects, make sure the Search Attachment Contents box is checked.

Using Wildcards

You can use wildcard characters in your search. Agile uses two wildcards: the asterisk (*) and the question mark (?). The question mark finds matches with any other single character. For example, ?at finds hat, cat, and fat, but not splat. The asterisk finds matches with more than one character. For example, *at finds cat, splat, and big hat. The asterisk by itself finds all objects of the specified class.

Note: If you use wildcards, try to make your search as narrow as possible. Otherwise, the search may not be able to return results because it matches too many rows in the database.
Configure Mode Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Object Types</td>
<td>Lists available object types for the Quick Search portlet.</td>
</tr>
<tr>
<td>Selected Object Types</td>
<td>Lists object types you selected. The order is important. The first object type listed is the default one used in the portlet.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
</tbody>
</table>

Report Folder Browser Portlet

Lets you generate reports from one of the Report folders. To generate a report, click any of the listed reports to open the Report wizard.

The Report Folder Browser portlet can be used on multiple portal pages, and you can configure different settings for each page. This allows you to specify different root Report folders on different pages.

Figure 4-15: Report Folder Browser portlet

<table>
<thead>
<tr>
<th>Available Object Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Object Types</td>
<td>Lists object types you selected. The order is important. The first object type listed is the default one used in the portlet.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
</tbody>
</table>

Edit Mode Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Tree</td>
<td>Displays a hierarchical list of report folders. Select one to use for the portlet.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
<tr>
<td>Use Defaults</td>
<td>Uses the default configuration.</td>
</tr>
</tbody>
</table>

Configure Mode Options

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option. See “Edit Mode Options” above. When you save settings in Configure mode, they become the default settings for the portlet.

Note     The Enable Customer External Reports checkbox option is not supported. Do not check that box.

Saved Search Portlet

The Saved Search portlet displays results for a saved search.
The Saved Search portlet must be configured properly before it can be used on a page. The portal administrator should make a copy of this portlet before adding it to a page and configuring it for a particular saved search.

Click an object’s number to load its data in another portlet, such as a Business Object portlet. You can also perform relevant actions for each object listed, such as Copy, Bookmark, and XLS (Save Table to Excel).

Note: The Saved Search portlet does not support parameterized searches, which prompt for search criteria when you run them.

**Configure Mode Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Tree</td>
<td>Displays a hierarchical list of search folders and searches. Select a saved search to use for the portlet.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration and returns to the page.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
</tbody>
</table>

**Search Folder Browser Portlet**

Allows you to browse search folders and select a particular search to run.

You can run any saved searches from the Search Folder Browser portlet, including parameterized searches, which prompt for search criteria when you run them.

To remove searches from your Personal Searches folder, click the Organize Your Personal Searches link at the bottom of the portlet. Select a search, and then click Delete. After that, click Return to go back to the normal portlet view.
**Note**  For searches that you run from the Search Folder Browser portlet, the display fields that appear in the Search Results are determined by how the searches have been defined.

**Edit Mode Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Tree</td>
<td>Displays a hierarchical list of search folders. Select a search folder from the tree to use for the portlet.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration and returns to the page.</td>
</tr>
<tr>
<td>Return</td>
<td>Returns to the page without saving.</td>
</tr>
<tr>
<td>Use Defaults</td>
<td>Uses the default configuration.</td>
</tr>
</tbody>
</table>

**Configure Mode Options**

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option. See “Edit Mode Options” above. In Configure mode, the Search Tree is used to select the base search folder for the portlet.

**Search Results Portlet**

Works in conjunction with the Advanced Search, Quick Search, and Search Folder Browser portlet. When you run a search in one of the search portlets, the results appear in the Search Results portlet.

Figure 4-18: Search Results portlet

From the search results, you can click objects to display them in another portlet, such as the Business Object portlet. You can also perform relevant actions for each object listed, such as Copy, Bookmark, and XLS (Save Table to Excel).

**Single Signon Portlet**

Allows single signon between the portal and the Agile PLM server.
Configure the Single Signon portlet to specify the user ID and password used to connect to the Agile PLM system. This same connection can be used for every Agile portlets page on the portal.

If you use Edit mode to change the Agile PLM user ID and password, make sure you log out and log back into the portal.

**Note** If you do not configure the Single Signon portlet correctly, other Agile portlets won’t work.

### Edit Mode Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile User ID</td>
<td>The user’s unique ID for logging into the Agile PLM system.</td>
</tr>
<tr>
<td>Agile User Password</td>
<td>The user’s login password.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels configuration changes.</td>
</tr>
</tbody>
</table>

### Upload File Portlet

Adds new files to the Agile PLM system. Specify the path of each file to upload, or click **Browse** to select it.
**Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Select a file to upload.</td>
</tr>
<tr>
<td><strong>Upload Files to the Same File Folders</strong></td>
<td>To upload files to the same folder, check this box. Otherwise, a separate</td>
</tr>
<tr>
<td></td>
<td>folder is created for each file.</td>
</tr>
<tr>
<td><strong>Unzip all Zip Files and Add Them as Individual Files</strong></td>
<td>If the file is a Zip file (an archive format), check this box to unzip the</td>
</tr>
<tr>
<td></td>
<td>file when you upload it.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select the File Folder type.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a brief description of the file.</td>
</tr>
<tr>
<td><strong>Upload File</strong></td>
<td>Creates a file folder containing the specified file. After the file is</td>
</tr>
<tr>
<td></td>
<td>uploaded, click Done to return to the portlet.</td>
</tr>
</tbody>
</table>

**User Profile Portlet**

Lets you view and edit the Agile PLM user profile for the current logged in user. The User Profile portlet is based on the Business Object portlet, but it’s specifically for the User class.

For information on how to use the Portlet Configurator to configure the User Profile portlet, see “Using the Portlet Configurator” on page 3-4.

**Note** If you change the password in the User Profile portlet, make sure you reset the password used in the Single Signon portlet as well.

**Figure 4-21: User Profile portlet**

---

**Sending Portlet Errors to the Portal Administrator**

If an error occurs with an Agile portlet, you may see the following message appear:

The system did not perform as expected. Please contact your Portal Administrator.
If you see such a message, there should also be a link below it that reads **Send Error To Portal Administrator**. Click the link to open your default email client and send the contents of the error message to the portal administrator.

**Note**  
The portal administrator’s email address must be specified in the `portalAdministratorEmail` application parameter. For more information, see “Setting Agile Portlet Services Application Parameters” on page 2-6.
CHAPTER 5
Troubleshooting

This chapter provides solutions to problems you may encounter with Agile portlets. It includes the following sections:

- Error Conditions
- Configuring Portlet Applications and Portlets
- Agile PLM Privileges
- Searches
- Business Object Portlet
- Importing Portal Configurations

Error Conditions

I get an APIException.getRootCause message for all portlets

When you try to display any portlet, an APIException.getRootCause message appears in the portlet.

Solution:
1. Make sure that the server.url parameter is correct and Agile PLM server is running.
2. Try to connect to http://plmserver.company.com:7777/Agile/ServerAPIProperties. If you can’t connect, there is a problem with the Agile PLM server. HTTP ports may be configured inconsistently between the Agile PLM server and the Oracle Application Server (OAS). For more details about HTTP port settings for OAS, see the Agile PLM Installation Guide.
3. If you updated the Agile PLM server or updated the Agile SDK JAR files, make sure you clean up the Agile SDK cache on the portal server. To clean up the cache, the portal administrator should stop the Portal Server and delete the AgileSDK.cache folder under c:\documents and settings\<user>\Local Settings\Temp.

Can’t find bundle for base name com.agile.util.ejb.AGILE_JNDI

When you try to display any portlet, a “Can’t find bundle for base name com.agile.util.ejb.AGILE_JNDI” message appears in the portlet.

Solution:
This is probably caused by a problem connecting from the portal to your application server. Make sure

- You can ping the application server.
- You specified the fully qualified domain name of the application server when you installed Agile PLM 9.2.1 and when you set portlet application parameters such as the server.url parameter.
HTTP ports are configured consistently on the application server. For details about HTTP port settings for Oracle Application Server, see the Agile PLM Installation Guide.

You are trying to connect to an Agile PLM 9.2.1 application server and not a server from a different Agile release.

You have cleared the Agile SDK cache. If you updated the Agile Portlet Services WAR file on your portal server, your portal server may be using older class files and therefore cannot connect to the updated Agile PLM server. See “Clearing the Agile SDK Cache” on page 2-13.

Java.lang.LinkageError: Class javax/activation/DataHandler

When using Agile portlets to download or upload files on WebSphere Portal Express 5.02, you get the following exception:

java.lang.LinkageError: Class javax/activation/DataHandler violates loader constraints: definition mismatch between parent and child loaders

The exception is caused by different versions of activation.jar being loaded within the classpath. The files conflict with the activation.jar file located in <was_root>/java/jre/lib/ext.

Solution:

To work around this problem, rename the following activation.jar files and give them unique names:

<wps_root>/shared/app/activation.jar
<wps_root>/wpcp/v5.0/author/lib/activation.jar

For example, you can rename the first file activation.jar.2 and the second one activation.jar.3

Note Depending on your environment, you may need to rename other copies of activation.jar to prevent conflicts. Search for any copies of activation.jar under the WebSphere folder. Do not rename the copy in <was_root>/java/jre/lib/ext.

This object has been modified, please refresh and try again

You were unable to save changes to an object due to an error. You clicked the error icon for a description of the error, and the following message box appeared: “This object has been modified, please refresh and try again.”

Solution:

The object was modified by another user after you entered Edit mode, preventing you from saving your changes. To re-enter your changes, do the following:

1. Click OK in the message box to close it.
2. Click Cancel to exit Edit mode and cancel your changes.
3. Click Refresh to refresh the object with the latest data from the server.
4. Choose Actions > Edit to enter Edit mode.
5. Re-enter your changes, and click Save.

When I add a file attachment to an object in the Business Object portlet, an error appears: “Cell [Title Block.Description] is read-only”

When you add a file attachment to an object in the Business Object portlet, you may see this error if you don’t have appropriate privileges for the File Folders class. The file attachment was added successfully, but the Title Block > Description field of the associated File Folder could not be updated. Make sure you have Modify privileges to the Title Block > Description field for the File Folders class.
Please select some BaseClasses first

In the Portlet Configurator, I’ve selected an object class on the Classes tab, and then clicked the Configure tab. An error message appears: “Please select some BaseClasses first!”

Solution:
Although you selected an object class, you didn’t click Add to define a class view. After you click Add, the portlet title you entered appears in the Defined Class Views list.

This Portlet Instance has not been configured

You tried to configure an Agile portlet in the page layout, and the following error appeared: “This Portlet Instance has not been configured. Please use the Configure or Edit Mode to set the required configuration parameters.”

Solution:
The portlet can only be configured from a portal page by using Configure or Edit mode. Do not try to configure the portlet from the page layout.

Configuring Portlet Applications and Portlets

Editing AgilePortlets 2.1 Application Parameters

You tried to edit AgilePortlets 2.1 application parameters, but you were unable to because the fields are read-only. You can add new parameters, but you can’t edit any of the existing parameters. In WebSphere Portal 5.0.x, you could modify the parameters.

Solution:
This is a known issue with WebSphere Portal 5.1.x. IBM Support has announced that it will be fixed in the next version of the WebSphere Portal product. To edit an application parameter, you have to delete it first and then recreate it with the new information.

I can’t launch the Portlet Configurator

When you try to launch the Portlet Configurator from the XML Configuration window for a portlet, the application doesn’t launch, or the configurator.jnlp file appears in your browser.

Solution:
1. Make sure the webClientVirtualPath portlet application parameter is correct.
2. Make sure the portletConfiguratorURL portlet application parameter is correct. It should point to the following URL:
   http://webserver:port/configurator/configurator.jnlp
3. Make sure you copied the <agile_home>\Portlet_51\configurator or <agile_home>\Portlet_50\configurator folder to your Web server’s docroot directory. On Internet Information Services (IIS), the default doc root is c:\inetpub\wwroot.
4. Make sure you configured the JNLP MIME type for your Web server.
5. Make sure Java Runtime Environment (JRE) 1.4.2 or later is installed on the client computer.
After I configure a portlet and return to the page, the portlet takes up the entire page

Sometimes after you configure a portlet, the portlet expands to fill the entire page even though there are other portlets in the layout.

Solution:
Click the Restore icon in the portlet’s title bar to restore it to its proper size.

Agile PLM Privileges

Some fields display “No Privilege”

When you view an Agile PLM object in a portlet, some fields display the value “No Privilege.” What does that mean? How can you get privileges to see those fields?

Solution:
The Enforce Field Level Read privilege determines whether the Read privilege is enforced for Agile PLM fields. If you have been assigned a role that includes the Enforce Field Level Read privilege, you may not be able to view the contents of specific fields. The words “No Privilege” appear in any field for which you don’t have Read privileges. If you want to be able to view all fields, ask your Agile PLM administrator to change your user account so that the field-level Read privilege is not enforced. For more information, see the Agile PLM Administrator Guide.

Searches

There were too many records found in your search. Please narrow down your search.

The wildcard search you ran matches too many rows in the database. When you run a search with a wildcard, the criteria must be matched against all words in the index, which can run into several million rows on a large database. Therefore, you should avoid creating wildcard searches that are too broad and that match too many rows in the database, for example, a search for “R*”.

By default, Agile PLM returns up to 1000 search results for any search. The Agile PLM administrator can increase the maximum number of search results, but doing so could adversely affect system performance.

A search that uses only an asterisk (*) for its criteria returns all records and is not subject to the maximum number of search results.

Solution:
If you see this error in the Search Results portlet, refine your search criteria and try again. Enter a more specific search string. For example, “Resistor*” is more specific than “R*”.

Business Object Portlet

All of my Business Object portlets are read-only

You configured several different Business Object portlets, but they are all read-only. You can’t modify objects that appear in the portlets. How can you make Business Object portlets editable?
Solution:

When you configure the portlet, make sure the Edit action is included in one of the Action Groups. The XML configuration for Action Groups should look like this:

```xml
<action-groups>
  <action-group id="0" name="Custom Actions" groupMode="1"
    collapseLimit="0" numberOfActionsToDisplayAsButtons="0">
    <action id="9" ref-id="%common.edit" name="Edit"/>
  </action-group>
</action-groups>
```

If you prefer to make a Business Object portlet read-only for your portal, don’t include the Edit action in any of the portlet’s Action Groups.

Of course, you can edit an object in Agile PLM only if you have the Modify privilege for that object. If you don’t have the Modify privilege, the Edit action is disabled.

For more information, see “Action Groups” on page 3-11.

---

**I can’t display the Gantt Chart**

From a Business Object portlet that displays program activities, you tried viewing the Gantt Chart by clicking the Gantt Chart action, but nothing happened, or you got the message “There is a problem logging into the Agile PLM Server. Please contact your administrator.”

Solution:

Make sure the `webClientVirtualPath` portlet application parameter is correct. See “Setting Agile Portlet Services Application Parameters” on page 2-6.

To check whether the Web client path is correct, open a browser and type the `webClientVirtualPath` value plus “/PLMServlet”. The Agile Web Client login screen should appear.

---

**I clicked the Assignment tab of a User Group, and the page displayed an error: “The system did not perform as expected.”**

You tried to display the Assignment tab of a User Group object in the Business Object portlet, but the page displayed an error.

Solution:

Log in as an portal administrator, and configure the Business Object portlet. Make sure the `User Group > Assignment > Date Group Table` attribute is not selected for any attribute groups. The Date Group Table attribute is not supported by Agile portlets.

---

**When I create a new Affected Item for a Change, the popup window doesn’t display all required fields**

You used the Business Object portlet to define a Change object, such as an ECO. On the Affected Items tab of the ECO, you clicked Create New to create a new part. However, the popup window that lets you create the part doesn’t display all of the required fields for that class.

Solution:

This is a known issue with the Business Object portlet. If you define Page Two or Page Three attributes to be required, they don’t appear in the popup window when you create a new part in the Affected Items tab of a Change. After you create the part, edit it to fill in the required fields.
I configured the Business Object portlet to message to the page, but it’s messaging to itself

You set the `portlet.messaging` parameter for a Business Object portlet to “page”. However, when you click a part in the BOM table, the portlet updates itself instead of messaging to other portlets on the same page.

Solution:

For objects supported by the Business Object portlet, the portlet overrides the `portlet.messaging` parameter and always messages to itself.

If you don’t want the Business Object portlet to message to itself for a particular class, don’t configure the portlet to support that class. However, the BOM table can’t message to the page because the table lists objects of the same class as the parent object, that is, other parts. Therefore, when you click a part on a BOM table, the portlet updates itself.

Importing Portal Configurations

I wasn’t able to import a portal configuration successfully using the XML Configuration Interface

You tried using the XML Configuration Interface to import a portal configuration, but it returned the following error:

   XMLA0009E: Could not connect to portal.

Solution:

Before trying to import a portal configuration that you exported using the XML Configuration Interface, remember to place the AgilePortletPack2.war file in the `<wps_root>\installableApps` folder. For complete details on the XML Configuration Interface, see the IBM WebSphere Portal InfoCenter.
INDEX

A
action groups 3-11
  process extensions 3-19
Action Items 4-10
activation.jar 5-2
administration 2-20
Administration page 2-18
administration settings 2-21
Advanced Search portlet 1-2, 4-3
  configuring 3-2
  personalizing 4-5
Agile Portlet Services and process extensions 3-18
  application parameters 2-6
  installing 2-6
  online help 3-21
  personalizing 4-2
  portlet parameters 2-13
  updating 2-12
  upgrading 2-12
Agile SDK cache 2-13, 5-1
AND NOT searches 4-5
AND searches 4-5
Attachment Files portlet 1-2, 4-6
  filtering data 4-2
  fix packs 2-2

B
Basic authentication 3-19
  bookmarks 4-7, 4-12
Bookmarks portlet 1-2
  breadcrumbs feature 4-8
  Business Object portlet 1-2, 4-8

C
cache
  Agile SDK 2-13, 5-1
  dynamic 2-3
  servlet 2-3
Change Status action 3-12, 3-13
Class Garbage Collection 2-3
clearPortletContentsIfMessageNotSupported portlet parameter 2-14, 3-16
Clipboard 4-9, 4-12
Clipboard portlet 1-2
codebaseForViewer parameter 2-8
Configure mode 3-2
  configuring MIME type 2-11
createMultipleFileFoldersOnUpload parameter 2-8
cumulative fix 2-2
customTitle portlet parameter 2-14
Data Source Connection Pool Size 2-3
disableTableStatusFlags portlet parameter 2-14
Display Due In list 4-11
download.javaPlugin.url parameter 2-7
Dynamic Cache Service settings 2-3
Edit mode 3-2, 4-2
Enable (Dynamic Cache) Service at Server Startup 2-3
Enable Servlet Caching 2-3
Enforce Field Level Read privilege 5-4
  errors 4-18
  exact phrase searches 4-5
  external reports 3-4
favorites See Bookmarks portlet features 4-1
  files
    attachments 4-6
    uploading 4-17
  filtering data 4-2
  fix packs 2-2
Gantt Chart 2-7, 5-5
Generic JVM Arguments 2-3
help 3-21
  Help mode 3-2
  help.base.url parameter 2-8
  help.relativePath portlet parameter 2-14
  help.url portlet parameter 2-14
IBM HTTP Server 2-2
  installing Agile Portlet Services 2-6
Java plugin 2-7
Java Runtime Environment (JRE) 2-7, 2-11, 5-3
Java Virtual Machine (JVM) settings 2-3
Java Virtual Machine Heap Size 2-3
Java Web Start 2-10, 2-11
JDBC Providers settings 2-3
JNLP files 2-10
jvueServerForViewer parameter 2-7
layout 2-19, 3-13
LDAP server 2-5
LinkageError exception 5-2
Maximum Heap Size 2-3
Microsoft Excel support 4-10, 4-11, 4-15, 4-16
MIME type configuration 2-11
mTTConfiguredViews portlet parameter 2-14
mTTPossibleViews portlet parameter 2-14
My Notifications and Requests portlet 1-2, 4-9
My Portal page 2-18
My Things To Do portlet 1-2, 4-10
navigating the portal 2-4
No Privilege message 5-4
notfConfiguredViews portlet parameter 2-15
notfPossibleViews portlet parameter 2-15
notifications 4-9
objectType portlet parameter 2-15
OR searches 4-5
Organize Favorites page 2-18

P
Page Customizer page 2-18
Page Properties page 2-18
pageid_Report_cstRptCfg-Enabled portlet parameter 2-15
pageid_Report_rootFolderId portlet parameter 2-15
parameterized searches 4-15
performance tuning 2-3
portal pages 2-18
portalAdministratorEmail parameter 2-8
portlet application parameters 2-6
Portlet Configurator